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Obiectivele acestui modul sunt: 
 

 

 Aplicarea operaţiilor elementare şi a conceptelor de bază ale aplicaţiei Microsoft Excel 

 Proiectarea şi crearea documentelor 

 Deschiderea, salvarea şi închiderea unui document 

 Utilizarea funcţiei de ajutor (Help) 

 

 Utilizarea opţiunilor de gestionare a datelor 

 Introducerea şi modificarea informaţiilor 

 Selectarea unei celule sau a unui grup de celule adiacente sau neadiacente, a rândurilor, 

coloanelor şi a foilor de calcul 

 Completarea automată a listelor şi a seriilor de date (AutoFill) 

 Inserarea şi ştergerea celulelor, a rândurilor, coloanelor, foilor de calcul 

 Modificarea dimensiunilor rândurilor şi coloanelor 

 Redenumirea foilor de calcul 

 

 Utilizarea opţiunilor de formatare 

 Formatarea celulelor şi a informaţiilor conţinute (tipul informaţiei, alinierea, fontul, 

chenarele, culorile de umplere) 

 Crearea, modificarea şi aplicarea stilurilor de formatare a celulelor 

 Aplicarea stilurilor de tabel 

 Ascunderea rândurilor, coloanelor şi a foilor de calcul 

 Protejarea celulelor din foile de calcul şi protejarea registrului 

 Formatarea celulelor în funcţie de una sau mai multe condiţii (Formatarea condiţionată) 

 

 Copierea şi mutarea informaţiilor conţinute în celule şi a foilor de calcul 

 Utilizarea opţiunilor de lipire specială 

 

 Căutarea şi înlocuirea conţinutului celulelor 

 

 Utilizarea formulelor şi a funcţiilor 

 Modalităţi de introducere a unei formule într-o celulă 

 Utilizarea unor funcţii de tip matematic, statistic, logic şi de dată calendaristică 

 Folosirea referinţei relative, absolute şi mixte a unei celule în formule şi funcţii 

 

 Aplicarea unor prelucrări specifice bazelor de date în tabelele Excel 

 Definirea unei liste ca tabel (Excel Table) 

 Ordonarea liniilor unui tabel în funcţie de valorile sau culorile uneia sau mai multor 

coloane (Sortarea) 

 Afişarea dintr-un tabel doar a acelor înregistrări ce se supun unuia sau mai multor criterii 

(Filtrarea) 

 Aplicarea de calcule rezumative pe grupuri în cadrul unui tabel (Subtotal) 

 

 Utilizarea unor tehnici şi procedee de realizare a diagramelor 

 Reprezentarea grafică a unor informaţii din document 

 Modificarea şi formatarea unei diagrame 
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 Utilizarea opţiunilor de vizualizare a documentului 

 Aplicarea opţiunilor de formatare a documentului 

 Aplicarea şi personalizarea temelor de document 

 Stabilirea orientării, marginilor, dimensiunii, chenarului, fondului cromatic, antetului, 

subsolului paginilor foii de calcul 

 Stabilirea zonelor de imprimare 

 

 Tipărirea unui document 

 Utilizarea opţiunilor privind imprimarea 



 

 

 

Ministerul Comunicaţiilor şi Societăţii Informaţionale                          Proiectul Economia bazată pe Cunoaştere 
 

 

Componenta proiect: „Extinderea accesului la tehnologiile ITC şi îmbunătăţirea cunoştinţelor de utilizare a calculatorului” 

Program de formare continuă: „Utilizarea calculatorului personal: aplicarea TIC în şcoală şi afaceri” 

Suport de curs pentru Modulul: „Bazele utilizării aplicaţiilor de calcul tabelar; aplicaţia EXCEL din Microsoft Office” 

Pag. 4 

 

 

CUPRINS 

4. CALCUL TABELAR CU MICROSOFT OFFICE EXCEL ----------------------------------------- 6 

4.1. Operaţii elementare şi concepte de bază ale aplicaţiei Microsoft Excel ---------------------------------------------- 6 
4.1.1. Generalităţi; Proiectarea şi crearea documentelor --------------------------------------------------------------------------- 6 
4.1.2. Deschiderea aplicaţiei ------------------------------------------------------------------------------------------------------------ 7 
4.1.3. Crearea unui registru nou -------------------------------------------------------------------------------------------------------- 9 
4.1.4. Funcţia „Ajutor” (Help) --------------------------------------------------------------------------------------------------------- 11 

4.2. Gestionarea datelor din foile de calcul ------------------------------------------------------------------------------------- 12 
4.2.1. Selectarea celulelor -------------------------------------------------------------------------------------------------------------- 12 
4.2.2. Introducerea şi modificarea informaţiilor ------------------------------------------------------------------------------------ 13 
4.2.3. Inserarea rândurilor / coloanelor / celulelor / foilor de calcul ------------------------------------------------------------ 15 
4.2.4. Ştergerea celulelor /rândurilor / coloanelor / foilor electronice de calcul ---------------------------------------------- 17 
4.2.5. Redimensionarea rândurilor / coloanelor ------------------------------------------------------------------------------------ 18 
4.2.6. Redenumire foi de calcul ------------------------------------------------------------------------------------------------------- 18 

4.3. Formatarea ---------------------------------------------------------------------------------------------------------------------- 19 
4.3.1. Formatarea celulelor ------------------------------------------------------------------------------------------------------------- 19 
4.3.2. Utilizarea stilurilor de celulă --------------------------------------------------------------------------------------------------- 25 
4.3.3. Utilizarea stilurilor de tabel ---------------------------------------------------------------------------------------------------- 26 
4.3.4. Ascundere rânduri, coloane, foi de calcul ------------------------------------------------------------------------------------ 28 
4.3.5. Protejarea datelor ----------------------------------------------------------------------------------------------------------------- 29 
4.3.6. Formatarea condiţională -------------------------------------------------------------------------------------------------------- 31 

4.4. Copierea informaţiilor -------------------------------------------------------------------------------------------------------- 36 

4.5. Căutarea / înlocuirea conţinutului unei celule ---------------------------------------------------------------------------- 38 

4.6. Formule şi funcţii -------------------------------------------------------------------------------------------------------------- 39 
4.6.1. Introducerea unei formule - expresie de calcul------------------------------------------------------------------------------ 39 
4.6.2. Utilizarea funcţiilor Excel ------------------------------------------------------------------------------------------------------ 40 

4.6.2.1. Funcţii matematice ------------------------------------------------------------------------------------------------------- 43 
4.6.2.2. Funcţii statistice ----------------------------------------------------------------------------------------------------------- 45 
4.6.2.3. Funcţia logică IF ---------------------------------------------------------------------------------------------------------- 48 
4.6.2.4. Funcţii pentru date calendaristice (Dată & Oră) --------------------------------------------------------------------- 49 

4.6.3. Referinţe absolute, mixte şi relative ------------------------------------------------------------------------------------------ 51 

4.7. Prelucrări de tip baze de date ----------------------------------------------------------------------------------------------- 52 
4.7.1. Sortarea ---------------------------------------------------------------------------------------------------------------------------- 53 
4.7.2. Filtrarea automată a datelor ---------------------------------------------------------------------------------------------------- 57 
4.7.3. Subtotaluri ------------------------------------------------------------------------------------------------------------------------- 60 

4.8. Diagrame ------------------------------------------------------------------------------------------------------------------------ 61 
4.8.1. Realizarea unei diagrame ------------------------------------------------------------------------------------------------------- 61 
4.8.2. Editarea diagramei --------------------------------------------------------------------------------------------------------------- 62 

4.9. Vizualizarea şi formatarea foii de calcul şi a registrului --------------------------------------------------------------- 67 
4.9.1. Modurile de vizualizare a foii de calcul -------------------------------------------------------------------------------------- 67 

4.9.1.1. Modul de vizualizare Aspect pagină ---------------------------------------------------------------------------------- 68 
4.9.1.2. Modul de vizualizare Examinare înaintea imprimării -------------------------------------------------------------- 70 
4.9.1.3. Modul de vizualizare Examinare sfârşit de pagină ------------------------------------------------------------------ 71 

4.9.2. Opţiuni de vizualizare ----------------------------------------------------------------------------------------------------------- 72 



 

 

 

Ministerul Comunicaţiilor şi Societăţii Informaţionale                          Proiectul Economia bazată pe Cunoaştere 
 

 

Componenta proiect: „Extinderea accesului la tehnologiile ITC şi îmbunătăţirea cunoştinţelor de utilizare a calculatorului” 

Program de formare continuă: „Utilizarea calculatorului personal: aplicarea TIC în şcoală şi afaceri” 

Suport de curs pentru Modulul: „Bazele utilizării aplicaţiilor de calcul tabelar; aplicaţia EXCEL din Microsoft Office” 

Pag. 5 

 

4.9.2.1. Deschiderea unui registru în mai multe ferestre --------------------------------------------------------------------- 72 
4.9.2.2. Îngheţarea panourilor (Freeze Panes) --------------------------------------------------------------------------------- 73 
4.9.2.3. Scindarea foii de calcul în panouri (Split) ---------------------------------------------------------------------------- 73 

4.9.3. Formatarea documentului ------------------------------------------------------------------------------------------------------- 74 
4.9.3.1. Aplicarea temelor de document ---------------------------------------------------------------------------------------- 74 
4.9.3.2. Formatarea foilor de calcul --------------------------------------------------------------------------------------------- 75 

4.10. Imprimarea---------------------------------------------------------------------------------------------------------------------- 81 
4.10.1. Imprimarea parţială sau integrală a unei foi sau a întregului registru ----------------------------------------------- 81 
4.10.2. Stabilirea opţiunilor de imprimare ----------------------------------------------------------------------------------------- 82 

4.11. Realizarea unor aplicaţii practice ------------------------------------------------------------------------------------------- 83 
4.11.1. Propunere temă practică – Situaţie tabelară şi graficul asociat ------------------------------------------------------- 83 
4.11.2. Propunere temă practică – Tabel de buget cu grafice de structură --------------------------------------------------- 84 
4.11.3. Propunere activitate practică - Situaţie tabelară cu facilităţi de bază ale aplicaţiei-------------------------------- 86 

 



 

 

 

Ministerul Comunicaţiilor şi Societăţii Informaţionale                          Proiectul Economia bazată pe Cunoaştere 
 

 

Componenta proiect: „Extinderea accesului la tehnologiile ITC şi îmbunătăţirea cunoştinţelor de utilizare a calculatorului” 

Program de formare continuă: „Utilizarea calculatorului personal: aplicarea TIC în şcoală şi afaceri” 

Suport de curs pentru Modulul: „Bazele utilizării aplicaţiilor de calcul tabelar; aplicaţia EXCEL din Microsoft Office” 

Pag. 6 

 

4. CALCUL TABELAR CU MICROSOFT OFFICE EXCEL 
 

4.1. Operaţii elementare şi concepte de bază ale aplicaţiei Microsoft Excel 

4.1.1. Generalităţi; Proiectarea şi crearea documentelor 

Microsoft Excel este cel de-al doilea program pe scara popularităţii din suita de programe 

Microsoft Office. Acesta face parte din gama aplicaţiilor de calcul tabelar, permiţând efectuarea 

prelucrărilor de date organizate sub formă de tabele în foi de calcul electronice. Excel oferă facilităţi de 

calcul, utilizând formule simple sau complexe, schimburi de informaţii între aplicaţii de acelaşi tip sau 

de tipuri diferite, reprezentări grafice, etc.. 

Aplicaţiile de calcul tabelar, printre care şi Microsoft Excel, servesc la organizarea şi procesarea 

informaţiilor, în special a acelora de tip numeric. Un registru Excel poate avea o multitudine de 

utilităţi, de la simple calcule aritmetice până la evidenţe de tip contabil şi financiar. Printre avantajele 

utilizării unei astfel de aplicaţii se pot menţiona: 

 Raportările şi situaţiile de tip economic dintr-o organizaţie se elaborează, de regulă, periodic 

(zilnic, săptămânal, lunar, trimestrial, anual), pe aceeaşi structură, doar că de fiecare dată cu 

alte valori. Din acest motiv, este suficient să se definească o singură dată structura foii de 

calcul (antetele de rând şi de coloană, formulele de calcul, etc.), urmând ca apoi raportările să 

fie completate periodic cu datele curente; 

 Datele utilizate în foile de calcul pot fi reprezentate grafic, astfel încât să poată fi prezentate 

într-o formă sugestivă şi sintetică; 

 Un registru Excel poate servi la crearea unor tabele complexe şi de mari dimensiuni. 

 

Etapele pentru proiectarea şi crearea unui document nou de calcul tabelar sunt: 

1. Definirea obiectivelor registrului şi ale foilor de calcul (situaţia stocurilor, un stat de plată, 

evidenţa veniturilor şi a cheltuielilor, etc.); 

2. Definirea cerinţelor foilor de calcul - stabilirea datelor de intrare, a calculelor ce se vor 

efectua asupra acestora şi a formei în care vor fi furnizate rezultatele; 

3. Construirea structurii foilor de calcul - antetele coloanelor şi ale liniilor, stabilirea celulelor 

cu date de intrare, a celor cu expresii de calcul, în conformitate cu cerinţele foii de calcul; 

această etapă implică şi stocarea documentului pe un suport electronic; 

4. Exploatarea foilor de calcul - introducerea datelor şi prelucrarea lor prin calculare, 

formatare, reprezentare grafică, astfel încât rezultatele să fie furnizate în forma dorită. 

 

Crearea şi procesarea unui registru Microsoft Excel presupune cunoaşterea celor mai uzuale 

caracteristici şi operaţii specifice aplicaţiilor de calcul tabelar (introducerea şi modificarea 

informaţiilor, formatarea numerică, crearea expresiilor de calcul, utilizarea diverselor categorii de 

funcţii, operarea cu tabele tip baze de date, reprezentarea grafică a datelor, etc.). 
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4.1.2. Deschiderea aplicaţiei 

Lansarea în execuţie se realizează astfel: Pornire → Toate programele → Microsoft Office → 

Microsoft Office Excel 2007 (Start → All Programs → Microsoft Office → Microsoft Office Excel 

2007). După lansarea în execuţie a programului, pe ecran apare fereastra Excel, prezentată în figura 

următoare. 

 
 

Lucrarea creată în Excel se numeşte Registru (Book; Workbook). Fiecare registru conţine un 

anumit număr de foi de calcul ( Sheet; Worksheet). 

Interfaţa Excel conţine elemente cunoscute din alte aplicaţii Microsoft Office, ca:   

 Bara de titlu, ce conţine numele registrului curent şi numele aplicaţiei; 

 Butonul Office (Office Button), situat în colţul stânga sus al ferestrei aplicaţiei, permite 

accesul la comenzi de bază de tipul: deschidere fişier nou sau existent, salvare, imprimare, 

închidere, dar şi la opţiunile de lucru ale aplicaţiei, din butonul Opţiuni Excel (Excel 

Options); 

 

 Bara instrumente acces rapid (Quick Access Toolbar), cu butoanele de comandă Salvare 

(Save), Anulare (Undo) şi Refacere (Redo). Această bară poate fi personalizată prin 

adăugarea sau eliminarea de butoane prin acţionarea butonului de comandă Particularizare 
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bară de instrumente Acces rapid (Customize Quick Access Toolbar)situat la capătul ei 

; 

 Panglica (Ribbon), proiectată pentru accesarea rapidă şi intuitivă a comenzilor, prin 

acţionarea butoanelor de comandă. Butoanele sunt organizate în grupuri de comenzi înrudite, 

fiecare grup purtând un nume, afişat dedesubtul butoanelor, iar grupurile, la rândul lor, sunt 

reunite, pe criterii logice, în file (taburi). Fiecare tab (filă) corespunde unui tip de activitate, 

cum ar fi: inserări, opţiuni de vizualizare, dispunere în pagină, etc. Grupurile specifice unei 

anumite activităţi se afişează la clic pe tabul corespunzător. Din motive de ergonomie, unele 

taburi sunt afişate doar atunci când sunt necesare, cum ar fi tabul Instrumente diagramă 

(Chart Tools), care apare doar atunci când este selectată o diagramă. Panglica poate fi 

minimizată temporar şi reafişată prin bifarea/debifarea opţiunii Minimizare panglică 

(Minimize the Ribbon), accesibilă din butonul  Particularizare bară de instrumente Acces 

rapid (Customize Quick Access Toolbar) sau la clic dreapta în zona panglicii. Altfel: dublu 

clic pe un tab sau combinaţia de taste Ctrl + F1; 

 

 Bara de stare, ce afişează informaţii privind starea de lucru din fereastră şi deţine, printre 

altele, instrumente pentru schimbarea modului de vizualizare şi a dimensiunii de vizualizare; 

 Barele de defilare (Scrollbars) pe orizontală şi verticală. 

Elementele de interfaţă specifice aplicaţiei Microsoft Excel sunt: 

 Zona de lucru, constituită din foaia de calcul curentă. Aceasta este împărţită în coloane 

(columns) şi linii sau rânduri (rows). Coloanele, în număr de 16.384, sunt numite, în ordine 

alfabetică, de la A la XFD, iar rândurile sunt identificate prin numere, în ordine crescătoare, 

de la 1 la 1.048.576. Intersecţia dintre un rând şi o coloană se numeşte celulă (cell). Fiecare 

celulă are o adresă formată din literele coloanei urmate de numărul rândului la intersecţia 

cărora se află (exemple: C15; BF183) 

 Bara de formule (Formula Bar), situată deasupra zonei de lucru, este împărţită în două zone, 

şi anume: 

o Caseta Nume (Name Box), situată în partea stângă, afişează adresa celulei curente şi 

permite deplasarea rapidă la o anumită celulă a cărei adresă sau nume se tastează în casetă 

o Bara de formule (Formula Bar), situată în partea dreaptă, permite afişarea şi editarea 

conţinutului celulei curente 

Afişarea sau ascunderea Barei de formule (Formula Bar) şi a Casetei Nume (Name Box) se 

realizează astfel: Buton Office → Opţiuni Excel → Complex → rubrica Afişare (Office 

Button → Excel Options → Advanced → rubrica Display), prin bifarea sau debifarea opţiunii 

Afişare bară formule (Show Formula Bar) sau tabul Vizualizare →  grupul 

Afişare/Ascundere → Bară de formule (tabul View → grupul Show/Hide → Formula Bar). 

Zonele Bara de formule şi Caseta Nume pot fi redimensionate pe înălţime şi lăţime prin 

glisare. 

 Lista cu indicatoarele foilor de calcul, situată în stânga barei de defilare pe orizontală şi 
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butoanele pentru deplasarea între acestea: 

|  -  vizualizarea începutului listei; 

  -  deplasarea listei spre început cu o foaie; 

 -  deplasarea listei spre sfârşit cu o foaie; 

|  -  vizualizarea sfârşitului listei. 

La un moment dat doar una din foile de calcul ale registrului este curentă şi aceasta se selectează 

cu clic pe numele ei din lista cu indicatoarele de foi. 

Fiecare foaie electronică de calcul are un nume implicit „Foaie” („Sheet”) urmat de un număr 

(Foaie1, Foaie2) (Sheet1, Sheet2). O celulă dintr-o foaie de calcul va fi referită în formulele de calcul 

prin nume foaie!referinţă celulă, (exemplu: Foaie1!A1sau Sheet1!A1) dacă referirea se realizează în 

altă foaie de calcul decât cea curentă. Dacă referirea se realizează în foaia de calcul curentă celula va fi 

referită doar prin referinţa sa (exemplu: A1). 

 

4.1.3. Crearea unui registru nou 

Într-o sesiune de lucru în Excel se poate crea un nou registru, pornind de la şablonul de registru 

gol, prin succesiunea de comenzi: 

Buton Office → Nou → din lista Şabloane se alege Necompletat şi recent → din panoul 

central al casetei de dialog se selectează Registru de lucru necompletat → Creare 

(Office Button → New → din lista Templates se alege Blank and recent → din panoul 

central al casetei de dialog se selectează Blank Workbook → Create) 

   

Observaţie: Deschiderea unui nou registru gol se poate face mai rapid din butonul de comandă Nou 

(New)al barei de acces rapid (pentru a-l poziţiona acolo de utilizează butonul 

Particularizare bară de instrumente Acces rapid (Customize Quick Access Toolbar). 

Salvarea fişierelor Excel se realizează din Buton Office → Salvare (Office Button → Save) sau 
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din butonul Salvare (Save)de pe bara de acces rapid. În cadrul acestei operaţii se stabilesc 

următoarele opţiuni: numele fişierului, în caseta Nume fişier (File Name); locaţia (folderul de stocare), 

prin selectarea acestuia din lista Salvare în (Save in); şi tipul fişierului, din lista Salvare cu tipul (Save 

as type). Documentele create cu Excel sunt implicit de tipul Registru de lucru Excel (Excel Workbook) 

cu extensia .xlsx. 

Observaţie: pentru a schimba tipul implicit de fişier în care se face salvarea, se va alege un alt tip 

urmând calea: Buton Office → Opţiuni Excel → Salvare → caseta Se salvează în 

următorul format (Office Button → Excel Options → Save → caseta Save files in this 

format). 

Registrul poate fi protejat prin Parolă pentru deschidere (Password to open) şi/sau Parolă 

pentru modificare (Password to modify), sau se poate recomanda accesul doar pentru citire, fără 

parolă Acces recomandat doar în citire (Read-only recommended). Aceste setări se realizează din 

Buton Office → Salvare ca → Instrumente → Opţiuni generale (Office Button → Save As → Tools 

→ General Options). 

 

Excel-ul permite stabilirea unor opţiuni suplimentare pentru salvare, şi anume 

 Realizarea unei copii de rezervă la fiecare salvare. Se bifează opţiunea Se creează 

întotdeauna copie de rezervă (Always create backup) din caseta de dialog menţionată anterior. 

 Salvarea pentru recuperarea automată din Buton Office → Opţiuni Excel → Salvare → se 

bifează opţiunea Salvare informaţii de recuperare automată la fiecare (Office Button → 

Excel Options → Save → se bifează opţiunea Save AutoRecover information every) şi se 

stabileşte perioada de timp după care va face automat salvarea.  

Schimbarea opţiunilor de salvare ale fişierului curent se realizează din Buton Office → Salvare 

ca (Office Button → Save As). 

Închiderea registrului curent se realizează din Buton Office → Închidere (Office Button → 

Close) sau din butonul Închidere fereastră (Close Window) al registrului. Părăsirea aplicaţiei 

presupune închiderea automată a tuturor registrelor deschise şi se realizează prin Buton Office → 

Ieşire din Excel (Office Button →  Exit Excel)sau din butonul Închidere (Close)de pe bara de titlu a 

aplicaţiei. 
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4.1.4. Funcţia „Ajutor” (Help) 

Ajutorul ( Help) reprezintă un ghid interactiv de ajutor. Lansarea în execuţie a ghidului se 

realizează din butonul  Ajutor pentru Microsoft Office Excel (Microsoft Office Excel Help) din bara 

de taburi a ferestrei aplicaţiei sau cu tasta funcţională F1. 

În urma executării acestei comenzi, apare una din ferestrele următoare, care prezintă mai multe 

taburi: 

       
 

 

 

       
 

Se poate face căutarea 

informaţiilor necesare accesând 

legăturile din această fereastră şi 

navigând din aproape în aproape. Se 

revine la o legătură accesată anterior 

sau se reia o cale parcursă cu 

butoanele Înapoi (Back) şi Înainte 

(Forward) din bara de instrumente a 

ferestrei Ajutor Excel (Excel Help).  

Caseta de căutare după 

cuvinte relevante permite căutarea 

unei expresii. Se scrie expresia în 

caseta Tastaţi cuvinte ce trebuie 

căutate (Type words to search 

for), apoi se apasă butonul 

Căutare (Search). Se va afişa o 

listă cu situaţiile în care se găseşte 

acel cuvânt. Se selectează o 

opţiune din listă, ceea ce va 

conduce la afişarea secvenţei 

respective de instrucţiuni şi 

explicaţii. 
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Ce aţi învăţat în acest capitol? 

 Noţiuni generale despre Microsoft Excel. 

 Cum se deschide aplicaţia Microsoft Excel. 

 Cum se salvează un document creat cu Microsoft Excel. 

 Cum se închide aplicaţia Microsoft Excel. 

 Care este rolul şi modul de utilizare al funcţiei “Ajutor” (Help). 

 

 

4.2. Gestionarea datelor din foile de calcul 

4.2.1. Selectarea celulelor 

Pentru multe acţiuni ce se efectuează în Microsoft Excel, trebuie să se selecteze în prealabil una 

sau mai multe celule. Există mai multe modalităţi de selectare a celulelor: 

 Selectarea unei celule – alegerea celulei ca celulă activă prin clic în celulă; 

 Selectarea unui bloc de celule (zona compactă de celule adiacente), se poate face în două 

moduri: 

clic pe una din celulele din colţul zonei → glisarea mausului până în colţul diagonal opus; 

clic pe una din celulele din colţul zonei → cu tasta Shift apăsată clic pe colţul diagonal opus. 

Adresa unui bloc de celule (zonă compactă de celule adiacente) se exprimă ca adresa primei 

celule din grup (colţul stânga sus), urmata de semnul „:” şi apoi de adresa ultimei celule a blocului 

(colţul dreapta jos). 

Butonul Afişare cuprins (Show 

table of Contens)  afişează 

structurat o tablă de cuprins a 

facilităţilor produsului Excel. Din 

lista afişată se selectează pe rând, 

cu dublu clic operaţia pentru care 

avem nevoie de documentaţie. În 

exemplu s-a afişat modul de 

filtrare a datelor de tip numeric. 



 

 

 

Ministerul Comunicaţiilor şi Societăţii Informaţionale                          Proiectul Economia bazată pe Cunoaştere 
 

 

Componenta proiect: „Extinderea accesului la tehnologiile ITC şi îmbunătăţirea cunoştinţelor de utilizare a calculatorului” 

Program de formare continuă: „Utilizarea calculatorului personal: aplicarea TIC în şcoală şi afaceri” 

Suport de curs pentru Modulul: „Bazele utilizării aplicaţiilor de calcul tabelar; aplicaţia EXCEL din Microsoft Office” 

Pag. 13 

 

Exemplu: 

  

 Selectarea unor celule/blocuri neadiacente – se selectează prima celulă/primul bloc → cu 

tasta Ctrl apăsată se selectează pe rând celelalte celule/blocuri; 

 Selectarea tuturor celulelor din foaia curentă – clic pe butonul de Selectare totală (aflat la 

intersecţia antetelor de rând şi de coloană); 

 Selectarea celulelor unui rând – clic pe numărul rândului; 

 Selectarea celulelor unor rânduri, dacă rândurile:  

 sunt adiacente - clic pe numărul primului rând şi se glisează până pe numărul ultimului 

rând dorit;  

 nu sunt adiacente - clic pe numărul primului rând şi, ţinând tasta Ctrl apăsată, clic pe 

numerele celorlalte rânduri sau se glisează peste rândurile respective; 

 Selectarea celulelor unei coloane - clic pe numele coloanei; 

 Selectarea celulelor unor coloane, dacă coloanele:  

 sunt adiacente - clic pe numele primei coloane şi se glisează până la numele ultimei 

coloane dorite;  

 nu sunt adiacente - clic pe numele unei coloane şi, ţinând tasta Ctrl apăsată, clic pe 

numele celorlalte coloane sau se glisează peste coloanele respective. 

4.2.2. Introducerea şi modificarea informaţiilor 

 Introducerea informaţiilor se realizează astfel: se selectează celula cu clic pe ea şi se tastează 

conţinutul. Acesta apare atât în celulă cât şi în bara de formule. Terminarea introducerii se face 

prin confirmarea informaţiilor introduse: 

 Tasta Enter – celulă activă devine celula de mai jos; 

 Clic pe butonul  de pe bara de formule – celulă activă rămâne tot celula curentă; 

 Tasta Tab – celulă activă devine celula din dreapta. 

sau prin renunţarea la introducerea acestor informaţii: 

 Tasta Esc – celulă activă rămâne tot celula curentă; 

 Clic pe butonul  de pe bara de formule – celulă activă rămâne tot celula curentă. 

B2:D9 
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 Modificarea conţinutului unei celule se realizează prin două metode: 

 Selectând celula cu clic pe ea, clic în bara de formule, apoi se operează modificarea, sau 

 Dublu clic în celulă, apoi se operează modificarea. 

Terminarea modificării se face ca mai sus. 

 Informaţiile în Excel sunt clasificate în două tipuri:  

 Informaţii numerice care cuprind numere întregi, numere zecimale, numere procentuale, 

numere însoţite de simboluri monetare, date calendaristice, momente de timp; implicit aceste 

informaţii se aliniază la dreapta celulei. 

 Informaţii text care conţin litere, numere şi alte simboluri; implicit aceste informaţii se 

aliniază la stânga celulei. 

 Facilităţi de introducere a datelor: 

 Completare automată (AutoComplete) – completează textul în curs de editare din celula 

curentă cu un text existent mai sus pe aceeaşi coloană şi care începe cu literele deja tastate. 

Se poate accepta completarea automată cu Enter, sau se poate continua editarea în cazul în 

care textul diferă de cel propus. Opţiunea de Completare automată (AutoComplete) nu este 

case-sensitive (nu se ţine cont de starea de majusculă sau minusculă a literei). Activarea sau 

dezactivarea ei se realizează astfel: Buton Office → Opţiuni Excel → Complex → rubrica 

Opţiuni de editare → Activare completare automată în celule (Office Button → Excel 

Options → Advanced → rubrica Editing options → Enable AutoComplete for cell values). 

 Umplere automată (AutoFill) – reprezintă o caracteristică pentru automatizarea introducerii 

datelor. Aceste date constituie liste sau serii de informaţii.  

Listele - reprezintă o înşiruire de informaţii de tip text. Pentru a utiliza o listă ea trebuie să existe. 

Există liste predefinite, dar pot fi şi liste create de utilizator. 

Listele pot fi vizualizate din Buton Office → Opţiuni Excel → Populare → rubrica Opţiuni 

principale pentru lucrul în Excel →  Editare liste particularizate (Office Button → Excel 

Options → Popular → rubrica Top options for working with Excel → butonul Edit Custom 

Lists…). 

 

Crearea unei liste de către utilizator se poate face prin două metode:  

 Din caseta de dialog de mai sus se face clic pe LISTĂ NOUĂ (NEW LIST), apoi în zona 

Intrări listă (List Entries) se tastează elementele listei separate prin Enter, apoi 

Adăugare ( Add )→ OK. 
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 Dacă elementele listei există deja într-un bloc de celule în foaia de calcul (pe un rând sau 

pe o coloană): se selectează acest bloc, apoi din caseta de mai sus se face clic pe butonul 

Import → OK. 

Ştergerea unei liste create de utilizator: 

Din caseta de  mai sus se selectează lista ce urmează a fi ştearsă din zona Liste particularizate  

(Custom Lists), apoi se face clic pe butonul Ştergere (Delete). Apare o casetă în care se cere 

confirmarea ştergerii. Pentru confirmare se apasă OK.  

Completarea automată a celulelor cu informaţii pe baza unei liste: 

Se tastează într-o celulă un element din listă → clic pe colţul dreapta jos al celulei, pe reperul 

de completare Umplere automată (AutoFill) şi se glisează mausul peste celulele ce se doresc 

umplute. 

Seriile - o serie de date poate reprezenta un şir de numere aflate în progresie aritmetică sau 

geometrică, date calendaristice ordonate după diverse criterii sau serii numerice cu text asociat. 

Completarea automată a celulelor cu serii numerice în progresie aritmetică 

Se completează în două celule alăturate doi termeni consecutivi ai unei serii de numere în 

progresie aritmetică → se selectează cele două celule (vezi selectarea celulelor) → clic pe 

reperul de umplere automată (AutoFill) al blocului cu celulele selectate şi se glisează mausul 

peste celulele ce se doresc umplute. 

Completarea automată a celulelor cu serie text 

Se tastează într-o celulă un element din serie → clic pe reperul de umplere automată 

(AutoFill) al celulei şi se glisează mausul peste celulele ce se doresc umplute. 

Exemplu:  

Umpleri automate pe bază de listă, serie numerică, serie text: 

 
 

4.2.3. Inserarea rândurilor / coloanelor / celulelor / foilor de calcul 

Pe parcursul lucrului în foaia de calcul se poate opta ca între anumite date să se mai introducă 

altele noi, fără a le pierde pe cele deja introduse. În acest caz se pot introduce celule, rânduri, coloane 

sau foi electronice de calcul goale care ulterior se vor umple cu datele dorite. 

 Inserare de rânduri 

Se selectează câte o celulă din fiecare rând ce va fi situat sub noile rânduri goale, apoi tabul 

Pornire → grupul Celule → din lista butonului Inserare → Inserare rânduri foaie (tabul Home 

→ grupul Cells → din lista butonului Insert → Insert Sheet Rows); 
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altfel: 

Se selectează cu clic pe numerele lor rândurile ce vor fi situate sub noile rânduri goale, apoi tabul 

Pornire → grupul Celule → Inserare (tabul Home → grupul Cells →  Insert)sau  clic dreapta pe 

selecţie → Inserare (Insert). 

 Inserare de coloane 

Se selectează câte o celulă din fiecare coloană ce va fi situată în dreapta noilor coloane goale, apoi 

tabul Pornire → grupul Celule → din lista butonului Inserare → Inserare coloane foaie (tabul 

Home → grupul Cells → din lista butonului Insert → Insert Sheet Columns); 

altfel: 

Se selectează cu clic pe numele lor coloanele ce vor fi situate la dreapta noilor coloane goale, apoi 

tabul Pornire → grupul Celule → Inserare (tabul Home → grupul Cells →  Insert) sau  clic 

dreapta pe selecţie → Inserare (Insert). 

 Inserare de celule 

Se selectează celulele ce se află pe poziţia unde se doresc celulele goale, noi, apoi tabul Pornire → 

grupul Celule → din lista butonului Inserare → Inserare celule (tabul Home → grupul Cells → 

din lista butonului Insert → Insert Cells (sau clic dreapta pe selecţie → Inserare (Insert)); Apare o 

casetă de dialog din care se alege acţiunea dorită a se efectua cu celulele selectate după 

introducerea celor noi, sau se poate opta pentru introducerea unor rânduri sau coloane noi întregi în 

zona selectată; 

 

 
 

Observaţie:  dacă după selectarea celulelor ce se găsesc pe poziţia unde vor fi inserate cele goale se dă 

direct clic pe butonul Inserare (Insert) din grupul  Celule (Cells) al tabului Pornire 

(Home), atunci se va executa implicit acţiunea de translatare către dreapta a celulelor 

înlocuite. 

 

 Inserarea foilor electronice de calcul  

Se selectează o foaie de calcul, apoi tabul Pornire → grupul Celule → din lista butonului Inserare 

→ Inserare Foaie (tabul Home → grupul Cells → din lista butonului Insert → Insert Sheet). Noua 

foaie de calcul se va poziţiona înaintea celei de pe care s-a dat comanda. Pentru a insera o foaie 

nouă la sfârşitul registrului, se dă clic pe butonul  Inserare foaie de lucru (Insert Worksheet), 

poziţionat la capătul din dreapta al listei cu indicatorii numelor foilor de calcul. 

 

Inserează rânduri noi 

Inserează coloane noi 

Translatează celulele 

selectate către dreapta 

Translatează celulele 

selectare către în jos 
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Observaţie:  pentru a insera simultan mai multe foi de calcul, se selectează în prealabil atâtea foi câte 

se doresc a fi inserate, apoi  tabul Pornire →  grupul Celule →  din lista butonului 

Inserare → Inserare Foaie (tabul Home → grupul Cells → din lista butonului Insert → 

Insert Sheet).  

 

4.2.4. Ştergerea celulelor /rândurilor / coloanelor / foilor electronice de 
calcul 

Datele din foaia electronică de calcul se pot şterge astfel: 

 Ştergerea conţinutului celulelor 

- Se selectează celulele → se apasă tasta Delete; această opţiune şterge doar conţinutul celulei, 

nu şi alte componente ale acesteia (formatări, comentarii); 

 

- Pentru a elimina dintr-o celulă doar anumite componente sau a o goli complet, după selectare 

→ tabul Pornire → grupul Editare → butonul Golire  (tabul Home → grupul Editing → 

butonul Clear )→ se alege una dintre opţiunile: 

    

 

 Eliminarea celulelor, rândurilor, coloanelor se realizează  astfel: 

- Se selectează celulele de şters sau aflate pe rândurile/ coloanele ce urmează a fi şterse → tabul 

Pornire → grupul Celule → din lista butonului Ştergere → Ştergere celule (tabul Home → 

grupul Cells → din lista butonului Delete → Delete Cells) 

-  

 

 

- Se alege din fereastră una dintre variantele ilustrate în imagine; 

Observaţie: dacă după selectarea celulelor se dă direct clic pe butonul Ştergere (Delete) din grupul 

Celule (Cells) al tabului Pornire (Home), atunci se va executa implicit acţiunea de 

translatare către în sus a celulelor aflate sub cele şterse. 

Translatarea celulelor din 

dreapta celor şterse către stânga 

Translatarea celulelor de sub 

cele şterse către în sus 

Ştergerea întregului rând 

Ştergerea întregii coloane 

Golire totală (Clear all)  - elimină toate componentele celulei 

Golire formate (Clear Formats) - elimină formatările şi păstrează 

conţinutul 

Golire cuprins (Clear Contents) - elimină doar conţinutul 

Golire comentarii (Clear Comments) - elimină doar comentariile 
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Altfel:  

Pentru ştergerea rândurilor şi a coloanelor se selectează celule de pe rândurile / coloanele ce 

urmează a fi şterse → tabul Pornire → grupul Celule → din lista butonul Delete → Ştergere 

rânduri foaie sau Ştergere coloane foaie (tabul Home → grupul Cells → din lista butonului 

Delete → Delete Sheet Rows  sau Delete Sheet Columns).  

 Ştergerea foilor de calcul (Ruperea) 

- Se selectează indicatorii foilor → tabul Pornire → grupul Celule → din lista butonului Delete 

→ Ştergere foaie (tabul Home → grupul Cells → din lista butonului Delete → Delete Sheet); 

altfel: clic dreapta pe indicatorul cu numele foii de calcul de şters → Ştergere (Delete). Foile 

şterse dispar definitiv din registru şi nu se mai pot reface. 

 

4.2.5. Redimensionarea rândurilor / coloanelor 

În cazul în care dimensiunea coloanelor ce conţin valori numerice este prea mică, în celulele 

respective se afişează eroarea ####. 

 

 Redimensionarea rândurilor/coloanelor se face indiferent de tipul informaţiilor conţinute, 

astfel: 

 Manual – se poziţionează mausul pe chenarul din dreapta numelui coloanei sau de sub 

numărul rândului şi se glisează până la dimensiunea dorită. 

 Automat – se selectează celule din rândul/rândurile sau coloana/coloanele respective → tabul 

Pornire → grupul Celule → butonul Format (tabul Home → grupul Cell → butonul Format) 

şi se alege una dintre variantele:  

 Pentru rând: 

o Înălţime rând (Row Height) - se stabileşte o dimensiune precisă a rândului/ 

rândurilor 

o Potrivire automată înălţime rânduri (AutoFit Row Height) - adaptează 

înălţimea rândului la cea mai înaltă informaţie conţinută; 

 Pentru coloană : 

o Lăţime coloană (Column Width) - se stabileşte o dimensiune precisă a 

coloanei/ coloanelor 

o Potrivire automată lăţime coloane (AutoFit Column Width) - adaptează 

lăţimea coloanei la cea mai lată informaţie conţinută. 

4.2.6. Redenumire foi de calcul 

1. Clic dreapta pe numele foii de calcul al cărei nume trebuie modificat. 

2. Din meniul contextual se alege comanda Redenumire (Rename) şi se tastează noul nume. 

O altă modalitate : se selectează foaia de calcul de redenumit → tabul Pornire → grupul Celule

→ butonul Format → Redenumire foaie (tabul Home → grupul Cell → butonul Format → Rename 

Sheet) şi se tastează noul nume. 
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Ce aţi învăţat în acest capitol? 

 Cum se realizează selectarea celulelor 

 Cum se introduc şi modifică informaţiile 

 Cum se lucrează cu serii şi liste de date 

 Cum se inserează şi se şterg celulele, rândurile, coloanele, foile de calcul 

 Cum se redimensionează rândurile şi coloanele 

 Cum se redenumesc foile de calcul 
 

4.3. Formatarea  

Pentru ca datele dintr-o foaie de calcul să poată fi interpretate mai uşor este indicat ca după 

introducerea lor să fie formatate, adică să li se schimbe aspectul (culoare, dimensiune, etc.). 

4.3.1. Formatarea celulelor 

Formatarea se realizează astfel:  

 

1. Se selectează elementele (celule, rânduri, coloane) în care există date al căror aspect se va 

schimba. 

2. Se alege tabul Pornire → grupul Celule → butonul Format → Formatare celule (tabul 

Home → grupul Cells → butonul Format → Format Cells) – pentru formatarea celulelor; 

altfel: clic dreapta pe celulele selectate → Formatare celule (Format Cells) 

Apare caseta de dialog Formatare celule (Format Cells). Aceasta conţine mai multe taburi: 

 

Tabul Număr (Number) – permite alegerea modului de reprezentare a diferitelor tipuri de date 

din celule, conform categoriei alese din lista Categorie (Category). Dintre categoriile cel mai des 

utilizate amintim: 
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 General (General) – anulează formatarea existentă pentru valori numerice. 

 Număr (Number) – permite:  

 Stabilire număr de zecimale  – Număr zecimale (Decimal places); 

 Afişare numere utilizând separator mii – Utilizarea separator mii (Use 1000 Separator); 

 Afişarea numere negative – Numere negative (Negative Numbers). 

 

   

 Procentaj (Percentage) – permite: 

 Transformarea valorii numerice existentă în celulă într-o valoare procentuală prin 

înmulţirea valorii iniţiale cu 100 şi adăugarea simbolului „%”; 

 Stabilire număr de zecimale (Decimal places). 

 Simbol monetar (Currency) – afişează valorile numerice însoţite de simbolul monetar şi 

permite: 

 Alegerea simbolul monetar din lista Simbol (Symbol). Simbolul implicit este cel ales 

pentru opţiunile regionale 

 Stabilire număr de zecimale (Decimal places); 

 Forma de afişare a numerelor negative (Negative Numbers). 
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 Dată (Date) – permite: 

 Selectarea diferitelor formate de afişare pentru data calendaristică din lista Tip (Type). 

  Oră (Time) – permite: 

 Selectarea diferitelor formate de afişare pentru momentul de timp din lista Tip (Type). 

 

O mare parte din opţiunile de formatare ale filei Număr (Number) a casetei de dialog Formatare 

celule (Format Cells) sunt disponibile şi din tabul Pornire → grupul Număr (tabul Home → 

grupul Number), şi anume: 

 

 lista Format de număr (Number Format) – alegerea categoriei/ tipului informaţiei  

 butonul Format număr contabil (Accounting Number Format) – alegerea unui simbol 

monetar 

 butonul Stil procent (Procent Style) – formatarea ca procentaj, fără zecimale 

 butonul Separator mii (Comma Style) – afişarea valorilor numerice cu separator de mie 

şi cu două zecimale 

 butonul Mărire zecimală (Increase Decimal) – creşterea numărului de zecimale afişate 

 butonul Micşorare zecimală (Decrease Decimal) – descreşterea numărului de zecimale 

afişate 

 

Tabul Aliniere (Alignment) – permite alinierea conţinutului celulei (pe orizontală şi verticală), 

orientarea, încadrarea textului în celulă, unirea mai multor celule (îmbinare celule). 
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 Aliniere text (Text alignment) permite alinierea textului pe Orizontală (Horizontal) şi pe 

Verticală (Vertical) în cadrul celulei. 

 Indent permite modificarea indentării (retragerii faţă de marginea celulei) a conţinutului 

celulei; fiecare unitate de indentare este echivalentul dimensiunii unui caracter 

 Orientare (Orientation) permite înclinarea textului cu un unghi, sau scrierea pe verticală. 

 Proprietatea Încadrare text (Wrap text) permite împărţirea automată a textului din celulă pe 

mai multe rânduri în funcţie de lăţimea celulei. 

 Proprietatea Potrivire prin reducere (Shrink to fit) permite redimensionarea textului din 

celulă astfel încât să se încadreze pe un singur rând în lăţimea coloanei. 

 Proprietatea Îmbinare celule (Merge Cells) permite unirea a două sau mai multe celule 

alăturate selectate şi transformarea lor într-o singură celulă; celula astfel obţinută va avea 

adresa primei celule din grupul selectat 

 

O mare parte din opţiunile de formatare ale filei Aliniere (Alignment) a casetei de dialog 

Formatare celule (Format Cells) sunt disponibile şi din tabul Pornire → grupul Aliniere (tabul 

Home → grupul Alignment), şi anume:  

 

 butoanele de tip Aliniere (Align… ) – diverse combinaţii de alinieri pe orizontală şi 

verticală 

 butonul  Orientare (Orientation) – înclinarea sau scrierea pe verticală 

 butoanele Mărire indent (Increase Indent)şi Micşorare indent (Decrease Indent) – 

creştere sau diminuarea retragerii conţinutului faţă de marginea celulei 

 butonul Încadrare text (Wrap Text) – împărţirea textului pe mai multe rânduri în 

interiorul celulei 

 butonul Îmbinare şi centrare (Merge and Center) – îmbinarea celulelor alăturate 
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selectate şi centrarea pe orizontală a conţinutului 

 

Tabul Font (Font) – permite precizarea formatarea fonturilor (caracterelor) după cum urmează:  

   

 Lista Font (Font) – permite alegerea unui corp de literă.  

 Lista Stil font (Font Style) permite alegerea stilului fontului:  

 Obişnuit (Regular) – valoare implicită; 

 Cursiv (Italic) – înclinat; 

 Aldin (Bold) – îngroşat; 

 Aldin Cursiv (Bold Italic) – îngroşat şi înclinat. 

 Lista Dimensiune (Size) – permite schimbarea dimensiunii fontului. 

 Lista Subliniere (Underline) – permite alegerea unui stil de subliniere. 

 Lista Culoare (Color) – permite modificarea culorii textului. 

 Tăiere text cu o linie (Stikethrough) – taie textul selectat cu o linie 

 Exponent (Superscript) – formatare ca exponent 

 Indice (Subscript) – formatare ca indice 

 

O mare parte din opţiunile de formatare ale filei Font a casetei de dialog Formatare celule 

(Format Cells) sunt disponibile şi din tabul Pornire → grupul Font (tabul Home → grupul Font), 

şi anume:  

 

 lista Font (Font) – alegerea corpului de literă 

 lista Dimensiune font (Font Size) – dimensiunea caracterelor 
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 butoanele Increase Size (Increase Size) şi Decrease Font Size (Decrease Font Size) – 

creşterea, respectiv diminuarea dimensiunii caracterelor cu câte o unitate 

 butoanele Aldin (Bold), Cursiv (Italic) – alegerea stilului caracterelor  

 lista butonului Subliniere (Underline) – alegerea unui stil de subliniere 

 lista butonului Culoare font (Font Color) – alegerea culorii caracterelor 

 

Tabul Bordură (Border) – permite alegerea stilului, culorii şi poziţiei chenarelor celulelor 

selectate. 

   

 Lista Stil (Style) – permite alegerea unui stil de linie. 

 Lista Culoare (Color) –  permite alegerea culorii liniei. 

 Zona Setări prestabilite (Presets) – conţine opţiunile pentru chenar astfel: 

 Fără (None) –  elimină chenarele existente; 

 Contur (Outline) – adaugă chenar exteriorului blocului de celule selectat; 

 Interior (Inside) – adaugă chenar interiorului blocului de celule selectat  

 

Configurarea chenarelor poate fi realizată şi din opţiunile butonului Borduri (Borders) din tabul 

Pornire → grupul Font (tabul Home → grupul Font).  

 

Tabul Umplere (Fill) – permite alegerea culorii de fundal pentru celulele selectate, astfel: 

 Lista Culoare fundal (Background Color) – alegerea culorii de fundal 

 Lista Culoare model (Pattern Color) – alegerea unei culori a liniilor de haşură 

 Lista Stil model (Pattern Style) – alegerea unui stil de haşurare 

 

Alegerea culorii de fundal pentru umplerea celulelor poate fi realizată şi cu ajutorul listei 

butonului Culoare de umplere (Fill Color) din tabul Pornire → grupul Font (tabul Home → 

grupul Font).  
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4.3.2. Utilizarea stilurilor de celulă 

Stilurile reprezintă un grup de formatări ce pot fi atribuite celulelor. Aplicaţia Microsoft Excel 

deţine o gamă variată de stiluri predefinite ce pot fi aplicate celulelor, dar pot fi create şi stiluri noi sau 

pot fi modificate cele existente.  Implicit celulele sunt formatate cu stilul Normal. 

Pentru operaţii cu stiluri de celulă: 

Tabul Pornire → grupul Stiluri → butonul Stiluri de celule (Tabul Home → grupul Styles → 

butonul Cell Styles) 

Aceasta ce conduce la afişarea unei liste cu stilurile disponibile în registrul curent. Fiecare dintre 

acestea poartă un nume. 

 

 
 

 Aplicarea unui stil se realizează astfel: 

1. Se selectează celula/celulele cărora li se va aplica noul stil 

2. În lista butonului Stiluri de celule (Cell Styles) se execută clic pe numele stilului de aplicat 

 

 Crearea unui stil nou se realizează astfel:  

1. Tabul Pornire → grupul Stiluri (tabul Home → grupul Styles) → se deschide lista butonului 

Stiluri de celule (Cell Styles) → Stil de celulă nou (New Cell Style) 

 
 

2. În caseta de dialog Stil (Style) se tastează, în caseta Nume stil (Style name), numele noului 

stil 
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3. Se debifează, dacă este cazul, acele componente de formatare ale celulei care nu vor fi 

incluse în noul stil 

4. Se acţionează butonul Format..., ceea ce conduce la deschiderea casetei de dialog Formatare 

celule (Format Cells)  

5. Se stabilesc formatările dorite 

6. OK → OK 

Observaţie:  se poate crea un stil nou şi prin duplicarea unuia existent şi asocierea unui alt nume şi a 

altor caracteristici de formatare pentru stilul duplicat. Pentru aceasta: în lista butonului 

Stiluri de celule (Cell Styles) se acţionează clic dreapta pe stilul de duplicat → Dublare 

(Duplicate) → se introduce un nou nume în caseta Nume stil (Style name) şi se stabilesc 

modificările în ce priveşte formatarea. 

 

 Modificarea unui stil existent se realizează astfel: 

1. Tabul Pornire → grupul Stiluri → se deschide lista butonului Stiluri de celule (tabul Home 

→ grupul Styles → se deschide lista butonului Cell Styles) 

2. Clic dreapta pe numele stilului care se doreşte modificat → Modificare (Modify) 

3. În caseta de dialog Stil (Style) se operează modificările necesare 

Modificarea unui stil va duce la modificarea corespunzătoare a tuturor celulelor formatate cu 

respectivul stil. 

 

 Ştergerea unui stil se realizează astfel: 

1. Tabul Pornire → grupul Stiluri → se deschide lista butonului Stiluri de celule (tabul Home 

→ grupul Styles → se deschide lista butonului Cell Styles) 

2. Clic dreapta pe numele stilului care se doreşte modificat → Ştergere (Delete)  

Ştergerea unui stil va conduce la formatarea cu stilul implicit (Normal) a celulelor care îl 

deţineau. 

Stilul Normal nu poate fi şters. 

 Eliminarea stilului celulelor se realizează prin formatarea respectivelor celule cu stilul Normal 

sau prin ştergerea stilului. 

 

4.3.3. Utilizarea stilurilor de tabel 

Tabel reprezintă, în accepţiunea Excel, o regiune compactă de celule, completată sau nu cu 

informaţii. Primul rând al tabelului poate reprezenta sau nu antetul acestuia, în sensul că celulele sale 

conţin sau nu etichete cu numele coloanelor tabelului. 

Un stil de tabel reprezintă o grupare de formatări de diverse tipuri ce se vor aplica celulelor, 

liniilor şi coloanelor tabelului. Există o galerie de stiluri predefinite, ce pot fi aplicate pe tabele, dar pot 

fi create şi propriile stiluri. 
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 Aplicarea unui stil se realizează astfel: 

1. Se selectează tabelul (regiunea compactă de celule) căruia i se va aplica noul stil 

2. Tabul Pornire → grupul Stiluri → butonul Formatare ca tabel (tabul Home → grupul Styles 

→ butonul Format as Table) 

3. În lista butonului Formatare ca tabel (Format as Table) se execută clic pe stilul de aplicat 

4. În caseta de dialog Formatare ca tabel (Format As Tabel), în zona Unde se găsesc datele 

pentru tabel? (Where is the data for your table?) se verifică sau eventual se modifică adresa 

tabelului şi se bifează opţiunea Tabelul meu are anteturi (My list has headers) dacă primul 

rând al tabelului este antetul acestuia →OK 

           

 

Tabelul va fi formatat conform stilului ales, şi, în plus, se mai poate observa: 

 În partea dreaptă a celulelor primului rând apar nişte elemente grafice (butoane de 

filtrare – fac obiectul capitolului 4.7.2). Pentru a le elimina:  

o Se renunţă la definirea de tip Tabel dar se păstrează formatarea cu clic oriunde în 

tabel → tabul Proiectare → grupul Instrumente → Conversie la interval (tabul 

Design → grupul Tools → Convert to Range)  

o Clic oriunde în tabelul formatat → tabul Date → grupul Sortare şi filtrare → se 

dezactivează cu clic pe el butonul Filtru   (tabul Data → grupul Sort and Filter 

→ se dezactivează cu clic pe el butonul Filter   

o Sau: tabul Pornire →  grupul Editare →  butonul Sortare şi filtrare →  se 

dezactivează cu clic pe ea comanda Filtru (tabul Home → grupul Edititng → 

butonul Sort & Filter → se dezactivează cu clic pe ea comanda Filter) 

 La clic oriunde în tabel, în panglica aplicaţiei (ribbon) se afişează instrumentele de lucru 

cu tabelele – Instrumente tabel (Table Tools) şi este adăugat tabul Proiectare (Design).  
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 Modificarea opţiunilor de formatare ale stilurilor: 

1. Clic oriunde în tabelul căruia i s-a asociat un stil de tabel 

2. Tabul Proiectare → grupul Opţiuni stil tabel (Tabul Design → grupul Table Style Options), 

cu următoarele opţiuni, ce funcţionează prin bifare/ debifare: 

  

 Rând antet (Header Row) – prin afişează/ascunde rândul de antet al tabelului 

 Rând total (Total Row) – creează un nou rând sub tabel care calculează şi afişează 

sumele câmpurilor cu valori numerice 

 Prima coloană (First Column) – formatare diferenţiată a primei coloane 

 Ultima coloană (Last Column) –  formatare diferenţiată a ultimei coloane 

 Rânduri alternante (Banded Rows) – formatare diferenţiată între rândurile pare şi impare 

 Coloane alternante (Banded Columns) – formatare diferenţiată între rândurile pare şi 

impare  

 Eliminarea stilului unui tabel se realizează astfel: 

1. Clic oriunde în tabelul care are asociat un stil 

2. Tabul Proiectare → se extinde grupul Stiluri tabel cu clic pe reperul Mai multe → Golire 

(Tabul Design → se extinde grupul Table Styles cu clic pe reperul More → Clear). 

 

4.3.4. Ascundere rânduri, coloane, foi de calcul 

Un rând, coloană, sau foaie de calcul ascunsă, nu mai apare nici pe ecran, dar nici pe hârtie, dacă 

se face tipărirea. 

 Ascunderea rândurilor, coloanele se realizează astfel: 

1. Se selectează rândul sau coloana respectivă 

2. Tabul Pornire → grupul Celule → butonul Format → Ascundere şi reafişare → Ascundere 

rând sau Ascundere coloane (tabul Home → grupul Cells → butonul Format → Hide and 

Unhide → Hide Rows sau Hide Columns) 

 Afişarea rândurilor, coloanele ascunse: 

1. Se selectează rândurile sau coloanele învecinate celei ascunse (sau se selectează întreaga 

foaie de calcul), apoi: 

2. Tabul Pornire → grupul Celule → butonul Format → Ascundere şi reafişare → Reafişare 

rând sau Reafişare coloane (tabul Home → grupul Cells → butonul Format → Hide and 

Unhide → Unhide Rows sau Unhide Columns)  
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Dacă a fost ascunsă prima coloană sau primul rând, pentru afişare se selectează întreaga foaie de 

calcul, apoi tabul Pornire → grupul Celule → butonul Format → Ascundere şi reafişare → 

Reafişare rând sau Reafişare coloane (tabul Home → grupul Cells → butonul Format → Hide 

and Unhide → Unhide Rows sau Unhide Columns). 

 Ascunderea foii de calcul se realizează din tabul Pornire → grupul Celule → butonul Format → 

Ascundere şi reafişare → Ascundere foaie (tabul Home → grupul Cells → butonul Format → 

Hide and Unhide → Hide Sheet). 

 Afişarea foii de calcul se realizează din tabul Pornire → grupul Celule → butonul Format → 

Ascundere şi reafişare → Reafişare foaie (tabul Home → grupul Cells → butonul Format → 

Hide and Unhide → Unhide Sheet). 

 

4.3.5. Protejarea datelor 

Protejarea presupune prevenirea editării (modificării, ştergerii) unei foi de calcul, a unui registru 

sau doar a anumitor celule dintr-o foaie de calcul. În cazul în care se doreşte protejarea anumitor celule 

dintr-o foaie de calcul împotriva modificărilor neautorizate, acele celule vor trebui întâi blocate prin 

formatarea cu opţiunea Blocate (Locked), şi abia apoi se va putea stabili protecţia foii de calcul, 

eventual cu parolă. 

Blocarea celulelor 

Primul pas este acela de a formata ca Blocate (Locked) acele celulele din foaia de calcul care vor 

fi protejate, şi a elimina această formatare pentru celelalte. Pentru aceasta: 

        

Această opţiune poate fi accesată şi din caseta de dialog Formatare Celule → fila Protecţie  

(Format Cells → fila Protection), prin bifarea/debifarea Blocate (Locked). 

Fila Protecţie (Protection) a casetei de dialog Formatare celule (Format Cells) permite, de 

asemenea ascunderea formulelor din celulele selectate (formulele nu vor mai fi afişate în bara de 

formule la selectarea celulei şi nici în celulă la dublu clic pe aceasta), cu opţiunea Ascunse (Hidden).  

Observaţie: Blocarea celulelor şi ascunderea formulelor nu au nici un efect atâta timp cât foaia de 

calcul nu este protejată, de aceea următoarea etapă va fi aceea de protejare a foii. 

1. Se selectează întreaga foaie de calcul (Ctrl + 

A) 

2. Tabul Pornire → grupul Celule (tabul Home 

→ grupul Cells) → butonul Format → se 

dezactivează opţiunea Blocare celulă (Lock 

Cell) cu clic pe ea pentru a deproteja întregul 

conţinut al foii de calcul  

3. Se selectează în foaia de calcul celulele ce vor 

fi protejate împotriva modificărilor 

4. Tabul Pornire → grupul Celule (tabul Home 

→ grupul Cells) → butonul Format → Blocare 

celulă (Lock Cell)  
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Protejarea unei foi de calcul 

Pentru a activa protecţia foii de calcul: 

Tabul Pornire → grupul Celule → butonul Format → Protejare foaie (Tabul Home → grupul 

Cells → butonul Format → Protect Sheet)  

 

     
 

După stabilirea protecţiei, în funcţie de drepturile alocate utilizatorilor, celulele blocate nu mai 

pot fi editate, sau, dacă s-a debifat Selectare celule blocate (Select locked cells), ele nu mai pot fi nici 

măcar selectate. 

Pentru a dezactiva protecţia aplicată foii de calcul: Tabul Pornire → grupul Celule → butonul 

Format → Deprotejare foaie (Tabul Home → grupul Cells → butonul Format → Unprotect Sheet) şi, 

dacă este solicitată, se introduce parola. 

Observaţie:  operaţia de protejare/deprotejare a foii de calcul se mai poate face şi din tabul Revizuire 

→ grupul Modificări → butonul Protejare foaie (tabul Review → grupul Changes → 

butonul Protect Sheet, respectiv Unprotect Sheet).  

 

 
 

Protejarea registrului de calcul 

Protejarea registrului presupune protejarea structurii acestuia şi a ferestrelor. Pentru protejarea 

registrului de calcul:  

Tabul Revizuire → grupul Modificări → butonul Protejare registru de lucru → Protejare 

structură şi ferestre  

(Tabul Review → grupul Changes → butonul Protect Workbook  → Protect Structure and 

Windows) 

Opţiunea Protejarea foii şi a conţinutului 

celulelor blocate (Protect worksheet and 

contents of locked cells) trebuie să fie bifată, 

pentru a asigura protecţia foii şi a celulelor 

blocate anterior. 

Foaia de calcul poate fi protejată pentru 

selectare, formatare, inserare, ştergere coloane 

şi linii, sortare, etc. Se poate, opţional, stabili şi 

o parolă pentru deprotejarea foii. 

Din lista Se permit tuturor utilizatorilor foii de 

lucru (Allow all users of this worksheet to:) se 

pot bifa operaţiile permise utilizatorilor atâta 

timp cât foaia este protejată. 
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Opţional, se poate stabili şi o parolă pentru deprotejarea registrului. 

 

 
 

 

Elementele de structură care pot fi protejate într-un registru de calcul sunt: 

 Vizualizarea foilor de calcul ascunse 

 Redenumirea foilor de calcul 

 Mutarea, ştergerea, ascunderea foilor de calcul 

 Inserarea de noi foi de calcul 

 Mutarea sau copierea foilor de calcul într-un alt registru 

 Înregistrarea de noi macrocomenzi 

 Crearea sumarului pentru scenarii 

 

Elementele ferestrelor ce pot fi protejate într-un registru de calcul sunt: 

 Schimbarea dimensiunii sau a poziţiei ferestrelor 

 Mutarea, redimensionarea sau închiderea ferestrelor 

Ridicarea protecţiei registrului de calcul de face din tabul Revizuire → grupul Modificări → 

butonul Protejare registru de lucru → se debifează opţiunea Protejare structură şi ferestre (tabul 

Review → grupul Changes → butonul Protect Workbook  → se debifează opţiunea Protect Structure 

and Windows). Dacă este nevoie, se introduce parola  OK. 

 

4.3.6. Formatarea condiţională 

Reprezintă aplicarea unor caracteristici de formatare doar acelor celule dintr-o selecţie care se 

supun unei sau mai multor condiţii (restricţii) precizate de utilizator, ceea ce facilitează analizarea 

informaţiilor, compararea lor, identificarea tendinţelor, a punctelor critice. Prin formatarea 

condiţională se pot evidenţia valorile supuse condiţiei cu ajutorul scalelor de culori, a barelor, a 

pictogramelor sau prin formate create de utilizator. 

Pentru aplicarea formatelor condiţionale: se selectează celulele care vor fi evaluate prin condiţie, 

apoi: 

 

Tabul Pornire → grupul Stiluri → butonul Formate condiţionale (tabul Home → grupul Styles 

→ butonul Conditional Formatting), şi, în funcţie aspectul ce se doreşte evidenţiat, se poate 

folosi: 
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 Formatarea celulelor folosind scale de culoare 

Această metodă de evidenţiere permite compararea celulelor utilizând un gradient de două sau 

trei culori. Prima culoare a schemei este atribuită celulelor cu valoare mare, iar ultima celor cu valoare 

mică (exemplu: scara Albastru – Galben - Roşu (Blue – Yellow – Red) va atribui nuanţe de albastru 

valorilor mari, nuanţe de galben valorilor medii şi nuanţe de roşu valorilor mici). 

 

Tabul Pornire → grupul Stiluri → butonul Formate Condiţionale → Scade de culoare →se 

alege o schemă de două/ trei culori 

(Tabul Home → grupul Styles → butonul Conditional Formatting → Color Scales → se alege o 

schemă de două/ trei culori) 

 Formatarea celulelor folosind bare de date 

Această metodă de evidenţiere permite compararea valorilor celulelor utilizând bare de date de 

diverse lungimi ce se afişează în celule. Lungimea unei bare sugerează valoarea numerică din celulă.  

 

Tabul Pornire → Grupul Stiluri → butonul Formate Condiţionale → Bare de date→ se alege o 

culoare a barelor 

(Tabul Home → Grupul Styles → butonul Conditional Formatting → Data Bars → se alege o 

culoare a barelor) 

 Formatarea celulelor folosind seturile de pictogramele 

Această metodă de evidenţiere permite clasificarea informaţiilor din celulele supuse evaluării în 

trei sau cinci categorii, prin atribuirea de pictograme.  Dintr-un set de pictograme, prima va fi asociată 

valorilor mari, în vreme ce ultima se va asocia valorilor mici. 
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Tabul Pornire → Grupul Stiluri → butonul Formate condiţionale → Seturi pictograme → se 

alege un set de pictograme, în funcţie de nevoile de evidenţiere 

(Tabul Home → Grupul Styles → butonul Conditional Formatting → Icon Sets → se alege un 

set de pictograme, în funcţie de nevoile de evidenţiere) 

 Formatarea folosind operatori de comparaţie 

Această metodă de aplicare a formatelor condiţionale permite evidenţierea anumitor celule dintr-

o selecţie pe baza unui criteriu comparativ (exemple: valorile egale, mai mari sau mai mici decât un 

termen de comparaţie, datele calendaristice dintr-un anumit interval, textele ce conţin anumite 

caractere, etc.), şi de asemenea, evidenţierea valorilor duplicate sau a celor unice. 

          

Tabul Pornire → grupul Stiluri → butonul Formate condiţionale → Evidenţiere reguli celule 

(Tabul Home → Grupul Styles → butonul Conditional Formatting → Highlight Cells Rules) → 

se alege comanda dorită, cum ar fi: Între (Between), Egal cu (Equal to), Text care conţine (Text 

that Contains), Apariţia unei date calendaristice (A Date Occuring), etc. → se precizează 

valoarea/ valorile de comparaţie şi caracteristicile de formatare de aplicat. 

Pentru formatarea condiţionată a valorilor duplicate sau a celor unice → comanda Valori dublate  

(Duplicate Values) → se alege Dublate (Duplicate) sau Unice (Unique) şi formatarea dorită din caseta 

de dialog ce va apare. 

 Formatarea celor mai mari/mici valori dintr-o listă şi a celor situate peste/sub media 

valorilor supuse evaluării 
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Această metodă permite evidenţierea: 

 Unui anumit număr de valori cele mai mari sau mai mici dintr-o listă - Primele 10 elemente 

(Top 10 Items) şi Ultimele 10 elemente (Bottom 10 Items); 

 A valorilor mai mari sau mai mici de o anumită pondere din totalul valorilor supuse evaluării 

- Primele 10% (Top 10%) şi Ultimele 10% (Bottom 10%); 

 A valorilor mai mari sau mai mici decât media aritmetică a valorilor celulelor selectate – 

Peste medie (Above Average) şi Sub medie (Below Average). 

     

Tabul Pornire → grupul Stiluri → butonul Formate condiţionale → Reguli primii/ultimii  

(Tabul Home → Grupul Styles → butonul Conditional Formatting → Top/Bottom Rules) → se 

alege comanda dorită → se precizează numărul de articole de evidenţiat sau procentul de 

comparaţie şi caracteristicile de formatare de aplicat  

 Crearea propriilor reguli de formatare condiţionată 

Pentru a crea propriile criterii şi formate condiţionale şi pentru a le gestiona, acestea se pot defini 

şi organiza în caseta de dialog Gestionar reguli formatare condiţională (Conditional Formatting 

Rules Manager). 

Tabul Pornire → Grupul Stiluri → butonul Formate condiţionale → Gestionare reguli 

Tabul Home → Grupul Styles → butonul Conditional Formatting → Manage Rules 

 

Această casetă de dialog permite vizualizarea tuturor regulilor de formatare condiţională 

existente în zona de celule selectată, pe anumite foi de calcul sau în întregul registru de lucru, în 

funcţie de alegerea făcută în lista Afişare reguli formatare pentru (Show formatting rules for). 

Pot fi create şi aplicate noi reguli, cu butonul Regulă nouă (New Rule), stabilindu-li-se tipul, 

descrierea şi caracteristicile de formatare aferente, pot fi modificate reguli existente, cu butonul 
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Editare regulă (Edit Rule),  şi se pot şterge reguli, cu butonul Regulă ştergere (Delete Rule). 

 Evidenţierea celulelor formatate condiţionat 

Într-o foaie de calcul vor putea fi identificate şi evidenţiate prin selectare celulele formatate 

condiţionat astfel: 

Tabul Pornire → grupul Editare → butonul Găsire şi selectare → Formate condiţionale 

(Tabul Home → grupul Editing → butonul Find & Select → Conditional Formatting) 

 Eliminarea formatării condiţionate 

 

Pentru a elimina formatările condiţionate ale anumitor celule dintr-o foaie de calcul, se 

selectează respectivele celule, apoi: 

Tabul Pornire → Grupul Stiluri → butonul Formate Condiţionale → Golire reguli→ 

Eliminare reguli din celulele selectate 

(Tabul Home → Grupul Styles → butonul Conditional Formatting → Clear Rules → Clear 

Rules from Selected Cells) 

Pentru a elimina formatările condiţionate din întreaga foaie de calcul 

Tabul Pornire → Grupul Stiluri → butonul Formate Condiţionale → Golire reguli→ 

Eliminare reguli din întreaga foaie 

(Tabul Home → Grupul Styles → butonul Conditional Formatting → Clear Rules → Clear 

Rules from Entire Sheet) 

 

 

 

 

Ce aţi învăţat în acest capitol? 

 Cum se formatează celulele şi informaţiile conţinute de acestea 

 Cum se utilizează şi creează stilurile de celule şi de tabel 

 Cum se pot ascunde rânduri, coloane şi foi de calcul 

 Cum se protejează celulele foilor de calcul şi documentele 

 Cum se poate realiza formatarea diferenţiată a celulelor în funcţie de una sau mai 

multe condiţii 

 

 

 

 

 

 



 

 

 

Ministerul Comunicaţiilor şi Societăţii Informaţionale                          Proiectul Economia bazată pe Cunoaştere 
 

 

Componenta proiect: „Extinderea accesului la tehnologiile ITC şi îmbunătăţirea cunoştinţelor de utilizare a calculatorului” 

Program de formare continuă: „Utilizarea calculatorului personal: aplicarea TIC în şcoală şi afaceri” 

Suport de curs pentru Modulul: „Bazele utilizării aplicaţiilor de calcul tabelar; aplicaţia EXCEL din Microsoft Office” 

Pag. 36 

 

4.4. Copierea informaţiilor 

Dacă în unele celule sunt date care sunt necesare şi în alte celule, ele se pot copia sau muta. 

După efectuarea operaţiei de copiere sau mutare, datele se plasează în celulele destinaţie, 

diferenţa constând în faptul că la copiere ele rămân şi în celulele sursă, pe când la mutare, datele dispar 

din celulele sursă. 

 

 Copierea/mutarea datelor din celule se poate face prin una din metodele: 

 

1. Se selectează celulele cu date (celulele sursă) → Clic pe marginea zonei selectate → se 

glisează mausul până în zona destinaţie (pentru mutare) sau cu tasta Ctrl apăsată se glisează 

mausul până în zona destinaţie (pentru copiere). 

2. Se selectează celulele cu date (celulele sursă) → tabul Pornire → grupul Clipboard → 

butonul Copiere (tabul Home → grupul Clipboard → butonul Copy) - pentru copiere sau 

butonul Decupare (Cut) - pentru mutare. Datele se plasează în Clipboard, de unde se pot 

prelua prin una din metodele: 

 Se selectează prima celulă din zona destinaţie → tabul Pornire → grupul Clipboard → 

butonul Lipire (tabul Home → grupul Clipboard → butonul Paste); zona destinaţie 

poate fi situată în foaia de calcul curentă, într-o altă foaie de calcul a documentului curent, 

sau într-un alt document. 

 Se selectează prima celulă din zona destinaţie → tabul Pornire → grupul Clipboard → 

se deschide lista butonului Lipire → Lipire specială (tabul Home → grupul Clipboard 

→ se deschide lista butonului Paste → Paste special); sau, mai rapid → clic dreapta în 

prima celulă a zonei destinaţie → Lipire specială (Paste special). Din casta de dialog 

care va apărea se aleg diverse opţiuni în lipire: 

 

 

 Zona Lipire (Paste) – se lipeşte numai componenta selectată a celulei 

o Totală (All) – lipeşte în întregime conţinutul şi formatările 

o Formule (Formulas) – copiază doar formula, ignorând valorile rezultate obţinute în 

urma calculului şi formatările 

o Valori (Values) – copiază doar valoarea ignorând formula de calcul 

o Formate (Formats) – copiază doar formatările 
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o Comentarii (Comments) – copiază doar comentariile ataşate celulei 

o Validare (Validation) – copiază doar regulile de validare impuse celulelor 

o Tot ce utilizează tema sursă (All using Source theme) – copiază întregul conţinut al 

celulei, păstrându-i tema de document  

o Tot exceptând bordurile (All Except Borders) – copiază conţinutul şi toate 

formatările, mai puţin chenarele 

o Lăţimi coloane (Column Widths) – copiază doar lăţimile coloanelor celulelor sursă 

o Formule şi formate de numere (Formulas and number formats) – copiază formulele 

şi formatările de tip număr – fila Număr (Number) a casetei de dialog Formatare 

Celule (Format Cells) 

o Valori şi formate de numere (Values and number formats) – copiază valorile şi 

formatările de tip număr 

 Zona Operaţii (Operation) – se efectuează operaţia aleasă între celulele destinaţie şi 

celulele sursă, iar rezultatul se plasează în celulele destinaţie. 

o Fără (None) – nu execută nici o operaţie. 

o Adăugare (Add) – adunare. 

o Scădere (Substract) – scădere. 

o Înmulţire (Multiply) – înmulţire. 

o Împărţire (Divide) – împărţire. 

 Transpunere (Transpose) – liniile sursei devin în destinaţie coloane iar coloanele devin 

linii. 

 Ignorare celule libere (Skip blanks) – celulele sursei care nu au conţinut nu se copiază; 

 Lipire cu legătură (Paste Link) – după copiere orice modificare în sursă se va actualiza 

automat şi în destinaţie. 

 Copierea/mutarea foilor de calcul se face astfel: 

1.  Se selectează indicatorii foilor sursă (prin clic pe indicatorul primei foi şi SHIFT + clic pe 

indicatorul ultimei foi pentru foile adiacente sau prin clic şi CTRL + clic pe toţi indicatorii 

foilor neadiacente). 

2.  Clic dreapta pe una din foile selectate → Mutare sau copiere (Move or Copy) → apoi se 

alege: 

 

 În registrul: (To book:) - registrul destinaţie (registru nou sau registru existent şi 
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deschis).  

 Înaintea foii: (Before sheet:) - foaia în faţa căreia se vor plasa foile copiate/mutate. 

Prin bifarea/nebifarea opţiunii Crearea unei copii (Create a copy), se alege dacă operaţia este de 

copiere sau de mutare. 
 

 

 

Ce aţi învăţat în acest capitol? 

 Cum se copiază informaţiile conţinute în celule 

 Care sunt opţiunile de lipire specială (Paste Special) 

 Cum copiază şi se mută foile de calcul 

 

 

4.5. Căutarea / înlocuirea conţinutului unei celule 

 Căutarea informaţiilor 

Tabul Pornire → grupul Editare → butonul Găsire şi selectare → Găsire (tabul Home → 

grupul Editing → butonul Find & Select  → Find )  

 

 
 

Caseta de dialog afişează sau ascunde opţiuni suplimentare de căutare prin apăsarea butonului 

Opţiuni (Options): 

 În caseta De găsit (Find what) se tastează informaţia căutată. 

 Din lista casetei În (Within) se alege căutare în foaia de calcul curentă sau în întreg registrul 

curent. 

 Opţiunea Potrivire litere mari şi mici (Match case)– se face distincţie între majuscule şi 

minuscule 

 Opţiunea Potrivire cu întreg conţinutul celulei (Match entire cell contents) – se caută o 

potrivire exactă şi completă cu caracterele specificate în caseta De găsit (Find what) 

Prin acţionarea succesivă a butonului Următorul găsit (Find Next) se selectează pe rând toate 

apariţiile şirului căutat. 

Pentru afişarea într-o listă sub fereastra de căutare a tuturor locaţiilor şirului căutat, se apasă 

butonul Găsirea tuturor (Find All). 
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 Înlocuirea informaţiilor 

Tabul Pornire → grupul Editare → butonul Găsire şi selectare → Înlocuire (tabul Home → 

grupul Editing → butonul Find & Select  → Replace)  

 

 În caseta De găsit (Find what) se introduce informaţia care va fi înlocuită. 

 În caseta Înlocuire cu (Replace with) se introduce informaţia cu care se va înlocui. 

Prin acţionarea succesivă a butonului Înlocuire (Replace), se înlocuiesc pe rând apariţiile şirului 

căutat. 

Butonul Următorul găsit (Find Next) trece peste o apariţie a informaţiei căutate fără înlocuire. 

Pentru înlocuirea tuturor apariţiilor informaţiei se apasă butonul Înlocuire peste tot (Replace 

All). 

 

 

Ce aţi învăţat in acest capitol? 

 Cum se caută sau se înlocuiesc informaţiile 

 

 

4.6. Formule şi funcţii 

4.6.1. Introducerea unei formule - expresie de calcul 

Formula – reprezintă expresie de calcul formată din: 

 Semnul „=” este în mod obligatoriu primul caracter în orice formulă 

 Operanzi (etichete, valori, referinţe de celule/blocuri de celule, funcţii); 

 Operatori: 

 aritmetici (+ adunare, - scădere, / împărţire, * înmulţire, ^ ridicare la putere); 

 logici (and, or, not); 

 relaţionali (> mai mare, >= mai mare sau egal, < mai mic, <=mai mic sau egal, = egal, <> 

diferit). 

 Paranteze rotunde pentru a schimba ordinea normală de efectuare a calculelor. 
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 Pentru introducerea unei formule se parcurg următorii paşi: 

1. Se selectează celula în care se aşteaptă rezultatul. 

2. Se tastează semnul „=”. 

3. Se introduc componentele formulei: 

 Operatori, paranteze – direct de la tastatură; 

 Operanzii se introduc de la tastatură sau, dacă aceştia sunt referinţe la celulele implicate în 

calcul, pot fi specificaţi şi prin selectare cu mausul direct din foaia de calcul. 

4. Se confirmă formula apăsând tasta Enter sau prin clic pe butonul  de pe bara de formule. 

Se renunţă la introducerea formulei pe parcursul tastării apăsând tasta Esc, sau prin clic pe 

butonul  de pe bara de formule. 

 

Exemplu: 

=100+200 

sau 

=300 +(A2+40)/5 

 Modificarea unei formule introdusă şi confirmată se realizează prin două metode: 

 În bara de formule – se selectează celula respectivă cu clic pe ea, se execută clic în bara de 

formule şi se operează acolo modificarea. 

 Direct în celulă – dublu clic în celulă, se obţine punctul de inserţie, apoi se operează 

modificarea. 

Confirmarea sau abandonarea modificării efectuate se face ca în descrierea de mai sus. 
 

4.6.2. Utilizarea funcţiilor Excel 

Funcţiile aplicaţiei Excel sunt instrumente încorporate de calcul care pot efectua calcule 

complexe din diverse domenii (baze de date, statistic, matematic, financiar, analitic, etc.).  

Orice funcţie este compusă din denumirea funcţiei şi argumentele funcţiei, precizate între 

paranteze rotunde. Există şi funcţii de tip volatil, fără argumente, dar chiar şi în cazul lor, după 

denumirea funcţiei apar două paranteze rotunde ().  

nume_funcţie (argumente) 

Multe dintre funcţii au mai multe argumente, constituite într-o listă de argumente. Separatorul de 

listă este punct şi virgulă (;) pentru setul de opţiuni regionale româneşti şi virgulă pentru setul de 

opţiuni regionale engleze (us). 

Observaţie: se schimbă setul de opţiuni regionale din configurările sistemului de operare, parcurgând 

calea: Pornire → Panou de control → Ceas, limbă şi regiune → Opţiuni regionale şi 

lingvistice → fila Formate (Start → Control Panel → Clock, Language and Region → 

Regional and Language Options → fila Formats) 

Introducerea unei funcţii într-o formulă se poate realiza în două variante: 
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 Varianta 1 pentru introducerea unei funcţii: prin utilizarea casetei de dialog Inserare funcţie 

(Insert Function). Această casetă de dialog poate fi accesată în diverse moduri: 

- Tabul Formule → grupul Bibliotecă de funcţii → butonul Inserare funcţie   (tabul 

Formulas →  grupul Function Library → butonul Insert Function) 

- Butonul Inserare funcţie Insert Function (fx) de pe bara de formule  

- Tabul Pornire → grupul Editare → se deschide lista butonului Însumare Automată → Mai 

multe funcţii (tabul Home → grupul Editing → se deschide lista butonului AutoSum → More 

Functions) 

 

- Tabul Formule → grupul Bibliotecă de funcţii → se deschide lista butonului Însumare 

automată → Mai multe funcţii (tabul Formulas → grupul Function Library → se deschide 

lista butonului AutoSum → More Functions) 

 

 
 

Ordinea efectuării operaţiilor de introducere a unei funcţii în caseta de dialog Inserare funcţie 

(Insert Function) este: 

1. Selectarea categoriei funcţiei din lista Selectaţi o categorie (Select a category) 

2. Selectarea funcţiei din lista  Selectaţi o funcţie (Select a Function), apoi clic pe butonul OK 

Notă: se poate selecta funcţia dorită şi direct din lista ce se deschide la acţionarea butonului 

corespunzător categoriei aparţinătoare, din tabul Formule →  grupul Bibliotecă de funcţii 

(tabul Formulas → grupul Function Library). 
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3. Apare caseta de dialog Argumente funcţie (Function Arguments), unde se face introducerea 

argumentelor funcţiei în casetele corespunzătoare, prin tastare sau prin selectare cu mausul 

din celule (referinţele celulelor implicate în calcul, valori numerice, etichete, alte funcţii, 

diverşi parametrii). Argumentele al căror nume apare scris aldin (bold) sunt obligatorii, 

celelalte fiind opţionale. Pe măsura introducerii argumentelor, rezultatul funcţiei apare în 

zona Rezultatul formulei (Formula Result), iar în bara de formule se poate vizualiza expresia 

introdusă. 

4. Confirmarea funcţiei introduse cu OK 

 

 
 

Observaţie: butoanele Restrângere dialog (Collapse Dialog) / Extindere dialog (Expand Dialog) 

 din dreapta casetelor de introducere a argumentelor permit, la clic pe ele, 

minimizarea, respectiv refacerea dimensiunii casetei de dialog, astfel încât să faciliteze 

vizualizarea şi selectarea datelor foii de calcul. 

 Varianta 2 pentru introducerea unei funcţii: prin tastarea funcţiei şi a componentelor sale direct 

în celula în care va fi returnat rezultatul, argumentele putând fi precizate prin tastare sau selectare 

cu mausul. 

 
 

Observaţie:  Aplicaţia Excel 2007 pune la dispoziţie facilitatea de completare automată a funcţiilor în 

formule, facilitate care funcţionează astfel: după tastarea în celulă a semnului „=” şi a 
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primei/primelor litere din numele unei funcţii, Excel afişează o listă derulantă ce conţine 

funcţiile al căror nume începe cu caracterele deja introduse; din această listă se poate 

alege, cu dublu clic pe numele ei, funcţia dorită. 

 

Editarea (modificarea) unei funcţii se poate face fie direct în celulă, fie în bara de formule, dar şi 

în caseta de dialog Insert Function, dacă se selectează celula de modificat şi se dă una dintre 

comenzile de deschidere a acesteia. 

În continuare vom exemplifica utilizarea câtorva funcţii din diverse categorii. 

 

Exemplu de sintaxă a funcţiei SUM: 

=SUM(lista argumente) - calculează suma valorilor referite în lista de argumente. 

Exemple de utilizare a funcţiei SUM: 

=SUM(10;20)               –   adună 10 cu 20. 

=SUM(A1;30;40)          –   adună conţinutul celulei A1 cu 30 şi cu 40. 

=SUM(A2:B4)              –   adună conţinutul celulelor A2,A3,A4,B2,B3,B4. 

=SUM(A1;30;A2:B4)  –  adună conţinutul celulei A1 cu 30 şi cu conţinutul celulelor A2, A3, 

A4, B2, B3, B4. 

4.6.2.1. Funcţii matematice 

Funcţiile din categoria Mat &Trig (Math &Trig) – Matematică şi trigonometrie - se întind de la 

simple formule pentru efectuarea unor calcule elementare până la funcţii complexe, mai degrabă utile 

unui matematician decât utilizatorului mediu al aplicaţiei Excel. 

 

SUM 

Funcţia SUM adună valorile precizate drept argumente. 

Sintaxa: SUM (number1; number 2; ...) 

unde number 1, number 2, ... sunt de la 1 la 30 de argumente pentru care se va obţine însumarea. 

 

Exemple:  SUM(A2:A8)  SUM(3;5) SUM(B2:B7;23) 

 

Observaţie: Funcţia SUM poate fi apelată printr-o facilitate suplimentară oferită de utilizarea butonului  

Însumare automată (AutoSum)  din tabul Pornire → grupul Editare (tabul Home → 

grupul Editing) sau tabul Formule → grupul Bibliotecă de funcţii (tabul Formulas → 

grupul Function Library). Există două variante, în funcţie de poziţia celulei rezultat relativ 
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la zona argumentelor, şi anume: 

a) dacă celula rezultat este adiacentă blocului de argumente (dedesubtul sau la dreapta 

acestuia), atunci se selectează argumentele şi celula în care se aşteaptă rezultatul şi se 

apasă butonul Însumare automată (AutoSum).  

 

 
 

b) dacă celula rezultat nu este adiacentă argumentelor, se apasă butonul  Însumare 

automată (AutoSum), se precizează între parantezele funcţiei argumentele (prin tastare 

sau prin selectare), apoi se confirmă introducerea formulei cu tasta Enter.  

 

SUMIF 

Funcţia SUMIF adună argumentele specificate printr-un criteriu dat. 

Sintaxa: SUMIF(range;criteria;sum_range) 

unde  

range reprezintă celulele ce vor fi evaluate de criteriul dat 

criteria reprezintă criteriul, sub forma unui număr, expresie sau text, care stabileşte care celule 

vor intra în adunare 

sum_range reprezintă celulele supuse operaţiei de adunare 

Observaţii:  

1) vor fi adunate doar acele celule din zona sum_range al căror corespondent din zona 

range îndeplinesc criteriul specificat 

2) dacă se omite argumentul sum_range, atunci vor fi supuse adunării celulele din zona 

range 

Exemplu: 

 

      

 

ROUND 

Funcţia ROUND rotunjeşte un număr la numărul specificat de zecimale 

Suma acelor valori vândute ale căror adaosuri sunt 

mai mari decât 1.000.000 

=SUMIF(B2:B5;”>1000000”;A2:A5) = 14 000 000 

 

Suma adaosurilor mai mari de 1.000.000 

=SUMIF(B2:B5;”>1000000”) = 2 800 000 
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Sintaxa: ROUND(number;num_digits) 

unde 

number este numărul ce se va rotunji 

num_digits reprezintă numărul de zecimale la care va fi rotunjit numărul  

 

Observaţii: 

1) dacă num_digits este 0, numărul va fi rotunjit la cel mai apropiat întreg 

2) dacă count este mai mic ca 0, numărul este rotunjit către stânga separatorului de 

zecimală 

 

Exemple: 

=ROUND (133,12548;2) = 133,13 

=ROUND (133,12548;0) = 133 

=ROUND (133,12548;) = 133 

=ROUND (133,12548;-1) = 130 

=ROUND (133,12458;-2) = 100 

 

INT 

Funcţia INT rotunjeşte în jos un număr până la cel mai apropiat întreg (furnizează drept rezultat partea 

întreagă a unui număr) 

Sintaxa: INT (number) 

Exemple:  INT(3,85) = 3  INT(-3,85) = -4 

 
4.6.2.2. Funcţii statistice 

Între funcţiile din categoria Statistice (Statistical) se regăsesc atât funcţii simple, pentru 

returnarea mediei aritmetice, minimului, maximului unui domeniu, numărare (AVERAGE, MIN, 

MAX, COUNT), dar şi funcţii statistice mai complexe, cum ar fi cele pentru calculul abaterilor 

absolute şi standard sau a diverselor tipuri de distribuţii sau de probabilităţi. 

 

MAX  

Funcţia MAX calculează maximul valorilor de tip numeric referite într-o listă de argumente  

Sintaxa: MAX(number 1;number 2;...) 

unde number 1; number 2;…sunt între 1 şi 30 de argumente ce pot conţine sau pot referi 

diverse tipuri de informaţii, dintre care însă se va calcula maximul doar al celor de tip 

numeric. 
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Exemplu:  

               

 

MIN  

Funcţia MIN calculează minimul valorilor de tip numeric referite într-o listă de argumente  

Sintaxa: MIN(number 1;number 2;...) 

unde number 1; number 2;…sunt între 1 şi 30 de argumente ce pot conţine sau pot referi 

diverse tipuri de informaţii, dintre care însă se va calcula minimul doar al celor de tip numeric. 

 

Exemplu:  

               

 

AVERAGE 

Funcţia AVERAGE calculează media aritmetică valorilor de tip numeric referite într-o listă de 

argumente  

Sintaxa: AVERAGE(number 1;number 2;...) 

unde number 1; number 2;…sunt între 1 şi 30 de argumente ce pot conţine sau pot referi 

diverse tipuri de informaţii, dintre care însă se va calcula media aritmetică doar pentru cele de 

tip numeric. 

 

Exemplu:  

               

Media aritmetică a notelor obţinute 

 

=AVERAGE(B13:B16) = 5,25 

Cea mai mică notă din listă 

 

=MIN(B13:B16) = 2 

Cea mai mare notă din listă 

 

=MAX(B13:B16) = 9 
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COUNT  

Funcţia COUNT numără celulele ce conţin informaţii de tip numeric şi numerele introduse într-o listă 

de argumente. 

Sintaxa: COUNT(value1;value2;...) 

unde value1; value2;…sunt între 1 şi 30 de argumente ce pot conţine sau pot referi diverse 

tipuri de informaţii, dintre care însă vor fi numărate doar cele de tip numeric. 

 

Exemplu:  

               

 

Observaţie: Funcţiile MAX, MIN, AVERAGE, COUNT pot fi apelate, pe lângă metodele generale 

enunţate anterior, şi prin selectarea lor din lista derulantă a butonului de comandă 

Însumare automată (AutoSum), procedându-se asemănător ca pentru funcţia SUM, cu 

menţiunea că funcţia COUNT se va regăsi în această listă sub denumirea de Count 

Numbers. 

 

COUNTIF 

Funcţia COUNTIF numără, dintr-o zonă de celule, doar pe acelea care îndeplinesc un criteriu dat. 

Sintaxa: COUNTIF(range;criteria) 

unde  

range este zona în care se va face numărarea 

criteria este un criteriu de selectare, sub formă de număr, expresie sau text 

 

Exemplu: 

 

       
 

 

 

Numărul elevilor cu numele Vlad 

=COUNTIF(A13:B16;”vlad”) = 2 

 

Numărul elevilor cu nota mai mică decât 5 

=COUNTIF(A13:B16;”<5”) = 2 

Numărul valorilor de tip numeric din 

blocul de celule A12:B16 

 

=COUNT(A12:B16) = 4 
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4.6.2.3. Funcţia logică IF 

Funcţia IF , din categoria Logice (Logical),  testează o condiţie şi returnează o valoare dacă condiţia 

precizată este adevărată (îndeplinită) şi o altă valoare dacă condiţia este falsă (nu este îndeplinită). 

Pentru evaluarea condiţiei logice la adevărat sau fals se utilizează operatori relaţionali (=, <>, <, >, <=, 

>=). 

Sintaxa: IF(Logical_Test;Value_if_true;Value_if_false) 

unde  

Logical_Test reprezintă condiţia, testul, şi este orice expresie ce poate fi evaluată ca adevărată 

sau falsă 

Value_if_true reprezintă rezultatul pentru condiţie adevărată (îndeplinită) 

Value_if_false reprezintă rezultatul pentru condiţie falsă (neîndeplinită); dacă este omisă, 

rezultatul pentru condiţie neîndeplinită va fi valoarea logică FALSE. 

 

Observaţie: Pot fi încapsulate până la 64 funcţii IF ca argumente ale testării unei condiţii mai 

elaborate. 

 

Exemple: 

1)  

      

 
 

2) În tabelul următor, Sporul se va calcula după formula: 

 Daca  vechimea < 3 ani → 1%*Salariu 

  3< vechimea<= 5 →  3%*Salariu 

  vechimea >5 ani →  5%*Salariu 

In celula C2 se va obţine Observaţia 

pentru primul elev după formula: 

Dacă Nota >=5, atunci „Promovat”, 

altfel „Respins”. 
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4.6.2.4. Funcţii pentru date calendaristice (Dată & Oră) 

Datele calendaristice şi momentele de timp sunt exprimate în Excel prin valori numerice 

seriale. Acestea sunt numere zecimale ale căror arte întreagă reprezintă numărul de zile care s-au scurs 

de la 01-ian-1900 până la respectiva dată, iar partea zecimală reprezintă momentul de timp de la ora 0 

la respectivul moment.  

 

Exemple: 

01-ian-1900→1 

18-iul-1900 → 200 

ora zero→  0  

ora 12 → 0,5 

 

Observaţie:  Microsoft Excel permite schimbarea datei de referinţă pentru asocierea valorilor numerice 

seriale ale datelor calendaristice din 01 ianuarie 1900 în 02 ianuarie 1904 dacă se bifează 

opţiunea Se utilizează sistemul de date 1904 (Use 1904 date system) din: Buton Office → 

Opţiuni Excel → Complex → rubrica Când se calculează registrul de lucru (Office 

Button → Excel Options → Advanced → rubrica When calculating this workbook). 

Se poate afla valoarea numerică serială a unei date calendaristice formatată cu categoria Dată 

(Date) sau a unui moment de timp formatat cu categoria Oră (Time) schimbându-i formatarea în tipul 

de dată General. 

Atunci când se realizează calcule cu date calendaristice (exp.: scăderi pentru a determina vârsta 

sau vechimea pornind de la data naşterii sau data angajării), Excel-ul va aplica aceste calcule valorilor 

numerice seriale asociate respectivelor date calendaristice, iar rezultatele vor fi exprimate în număr de 

zile. 

Facilităţi de introducere a informaţiilor de tip Dată şi Oră (Date şi Time): 

• Introducerea datei calendaristice curente (se apasă simultan tastele Ctrl +  ; ) . 

• Introducerea orei curente (se apasă simultan tastele Ctrl + Shift +  ;) . 

 
TODAY 

Funcţia TODAY întoarce drept rezultat valoarea numerică serială a datei curente. Dacă celula rezultat 

era iniţial formatată cu tipul de dată General, atunci rezultatul va fi furnizat în formatul Dată (Date). 

Sintaxa: TODAY() 

Observaţii: 

1) este o funcţie volatilă, deci nu acceptă argumente 

 

Pentru salariatul Popa formula poate fi: 
=IF(C2<3;B2*1%;IF(C2<=5;B2*3%;B2*5%)) 



 

 

 

Ministerul Comunicaţiilor şi Societăţii Informaţionale                          Proiectul Economia bazată pe Cunoaştere 
 

 

Componenta proiect: „Extinderea accesului la tehnologiile ITC şi îmbunătăţirea cunoştinţelor de utilizare a calculatorului” 

Program de formare continuă: „Utilizarea calculatorului personal: aplicarea TIC în şcoală şi afaceri” 

Suport de curs pentru Modulul: „Bazele utilizării aplicaţiilor de calcul tabelar; aplicaţia EXCEL din Microsoft Office” 

Pag. 50 

 

2) se actualizează automat la deschiderea registrului de calcul 

 

DAY 

Funcţia DAY returnează ziua unei date calendaristice reprezentate ca valoare numerică serială. Ziua 

este furnizată ca număr întreg cuprins între 1 şi 31. 

Sintaxa: DAY(serial_number) 

unde serial_number poate fi introdusă ca numărul de zile scurse de la 01.01.1900, ca referinţă 

la o celulă ce conţine o dată calendaristică validă sau ca o expresie de dată calendaristică ce 

returnează o dată validă. 

 

Exemple: 

=DAY(39583) = 15 

=DAY(D8) = 15,  unde celula D8 conţine 15.05.2008 

 

MONTH 

Funcţia MONTH returnează luna unei date calendaristice reprezentate ca valoare numerică serială. 

Luna este furnizată ca număr întreg cuprins între 1 şi 12. 

Sintaxa: MONTH(serial_number) 

unde serial_number poate fi introdusă ca numărul de zile scurse de la 01.01.1900, ca referinţă 

la o celulă ce conţine o dată calendaristică validă sau ca o expresie de dată calendaristică ce 

returnează o dată validă. 

 

Exemple: 

=MONTH(39583) = 5 

=MONTH(D8) = 5,  unde celula D8 conţine 15.05.2008 

 

YEAR 

Funcţia YEAR returnează anul unei date calendaristice reprezentate ca valoare numerică serială. Anul 

este furnizată ca număr întreg cuprins între 1900 şi 9999. 

Sintaxa: YEAR(serial_number) 

unde serial_number poate fi introdusă ca numărul de zile scurse de la 01.01.1900, ca referinţă 

la o celulă ce conţine o dată calendaristică validă sau ca o expresie de dată calendaristică ce 

returnează o dată validă. 

Exemple: 

=YEAR39583) = 2008 

=YEAR(D8) = 2008,  unde celula D8 conţine 15.05.2008 
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WEEKDAY 

Funcţia WEEKDAY transformă o valoare numerică serială într-o zi a săptămânii, luând implicit valori 

de la 1 la 7 (1 pentru Duminică, 2 pentru Luni, ..., 7 pentru Sâmbătă).  

Sintaxa: WEEKDAY(serial_number;return_type) 

unde  

serial_number poate fi introdusă ca numărul de zile scurse de la 01.01.1900, ca referinţă la o 

celulă ce conţine o dată calendaristică validă sau ca o expresie de dată calendaristică ce 

returnează o dată validă 

return_type este un număr ce stabileşte modelul de interpretare a rezultatului 

1 sau omisiune →  1 pentru Duminică până la 7 pentru Sâmbătă 

2 →    1 pentru Luni până la 7 pentru Duminică 

3 →    0 pentru Luni până la 6 pentru Duminică 

 

Exemplu: WEEKDAY (A2) = 5 , unde celula A2 conţine data calendaristică 25.12.2008 

 

4.6.3.  Referinţe absolute, mixte şi relative 

O facilitate a aplicaţiei Calc este reprezentată de posibilitatea copierii formulelor între celule. 

Regulile privind copierea sunt cele prezentate la capitolul „Copierea informaţiilor”. 

Celulele sursă pot fi referite diferit, în funcţie de rezultatul aşteptat în urma copierii formulei.  

Referinţele celulelor pot fi:  

 Relative – acest tip de referinţă se modifică la copierea formulei. 

 Absolute – acest tip de referinţă nu se modifică (rămâne constant şi numărul rândului şi litera 

coloanei) la copierea formulei. 

 Mixte – acest tip de referinţă îşi modifică fie numărul rândului, fie litera coloanei (rămâne 

constant fie litera coloanei, fie numărul rândului) la copierea formulei. 

Componenta, din adresa unei celule, care rămâne constantă va fi precedată de semnul „$”. 

Exemple de tipuri de referinţe: 

 Relative: A1, F22 se modifică ambele componente ale adresei. 

 Absolute: $A$1, $F$22 rămân constante ambele componente. 

 Mixte: $A1, A$1, semnul $ indicând componenta din adresă care rămâne constantă prin 

copiere; rămâne constantă litera coloanei ($A1), rămâne constant numărul rândului (A$1). 

Exemplu de utilizare a referinţelor: 

În celula B12 a tabelului din figură s-a calculat suma blocului B5:B11 (această sumă reprezintă 

valoarea vânzărilor). În celula C5 s-a calculat ponderea vânzărilor de mere din totalul vânzărilor 

(ponderea reprezintă raportul dintre valoarea vânzării produsului mere şi totalul vânzărilor). 
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Pentru a copia formula din celula C5 în blocul C6:C11 trebuie ca referinţa celulei ce conţine 

valoarea produsului (B5) să fie o referinţă relativă, iar referinţa celulei ce conţine valoarea totalului 

(B12) să fie mixtă. Acest lucru este necesar deoarece prin copierea formulei ponderii pe coloană, 

trebuie să rămână constant numărul rândului din referinţa B12. Această referinţă se introduce astfel: 

B$12.  

Observaţie: Schimbarea tipului de referinţă în timpul editării se poate face prin apăsarea tastei 

funcţionale F4.  

 

 

Ce aţi învăţat în acest capitol ? 

 Cum se introduc şi se modifică formule simple de calcul 

 Cum se introduce o funcţie într-o formulă 

 Cum se lucrează cu funcţiile matematice, statistice, logice şi de date calendaristice 

 Ce reprezintă şi cum se utilizează referinţe absolute, mixte şi relative. 

 

4.7. Prelucrări de tip baze de date 

Prelucrările de tip baze de date se aplică în Excel unor tabele alcătuite astfel:  

 Primul rând conţine în fiecare celulă câte o etichetă numită „nume câmp” şi care este numele 

coloanei respective. 

 Următoarele rânduri conţin informaţii specifice fiecărui câmp. 

 Tabelul tip bază de date se termină automat când întâlneşte un rând sau o coloană liberă. 

 Nu conţine celule îmbinate (Merge). 

Selectarea unui tabel cu structură tip bază de date pentru operaţiuni specifice se face cu clic 

oriunde în tabel, nefiind necesară marcarea vizuală a întregului tabel. 

Versiunea Excel 2007 permite, în plus, definirea unei astfel de liste ca Tabel Excel (Excel 

Table). Într-un tabel astfel definit, operaţiile de tip sortare, filtrare, calculare automată, formatare sunt 

mult simplificate faţă de versiunile anterioare.  

 Definirea unui Tabel (Table) 

1. Clic oriunde în tabelul de tip listă → tabul Inserare → grupul Tabele → butonul Tabel 
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(tabul Insert → grupul Tables → butonul Table) 

2. În caseta de dialog Creare tabel (Create Table), în caseta Unde se găsesc datele pentru 

tabel? (Where is the data for your table?) trebuie precizată adresa tabelului. Dacă primul 

rând al tabelului reprezintă antetul acestuia, se bifează opţiunea Tabelul meu are anteturi 

(My table has headers), altfel, nu. → OK 

 

Această operaţie va conduce la următoarele modificări: 

 

 Formatarea automată a tabelului cu un stil de tabel determinat de tema documentului (theme) 

 Apariţia în fiecare celulă din primul rând al tabelului a butoanelor de filtrare automată, care 

vor permite aplicarea rapidă de sortări şi filtrări 

 La clic oriunde în tabel apare în panglica aplicaţiei Instrumente tabel (Table Tools) cu tabul 

Proiectare (Design) , care oferă instrumente de formatare a tabelului (prezentate la 

capitolul 4.3.3 Utilizarea stilurilor de tabel) 

 Renunţarea la definirea unei liste ca Tabel (Table) 

1. Clic oriunde în Tabelul definit ca atare 

2. Tabul Proiectare → grupul Instrumente → butonul Conversie la interval  (Tabul Design → 

grupul Tools → butonul Convert as Range)→ OK  

 

4.7.1. Sortarea 

Sortarea reprezintă ordonarea înregistrărilor unui tabel în ordine alfabetică, numerică sau 

cronologică, după culoarea de umplere a celulelor, culoarea fonturilor, după simboluri grafice, 

ascendent sau descendent, după unul sau mai multe criterii de sortare. 

Observaţie: Aplicaţia Microsoft Excel 2007 permite aplicarea de până la 64 de criterii de sortare într-

un tabel 

 Sortarea având drept criteriu o singură coloană: 

1. Clic într-o celulă a coloanei criteriu de sortare 
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2. Tabul Pornire → grupul Editare → butonul Sortare şi filtrare (Tabul Home → grupul 

Editing → butonul Sort & Filter) → în funcţie de natura informaţiilor conţinute şi de 

ordinea de sortare se alege: 

o Pentru informaţii de tip şir de caractere → Sortare de la A la Z (Sort A to Z) sau 

Sortare de la Z la A (Sort Z to A) 

 

o Pentru informaţii de tip numeric → Sortare de la cel mai mic la cel mai mare (Sort 

Smallest to Largest) sau Sortare de la cel mai mare la cel mai mic (Sort Largest to 

Smallest) 

 

o Pentru informaţii de tip dată calendaristică/ timp → Sortare de la cel mai vechi la cel 

mai nou (Sort Oldest to Newest) sau Sortare de la cel mai nou la cel mai vechi (Sort 

Newest to Oldest) 

 

o Sortarea după culoarea de umplere a celulelor → Sortare particularizată (Custom 

Sort) → în caseta de dialog Sortare (Sort) se precizează:  

 

 În caseta Sortare după (Sort By) – numele coloanei criteriu de sortare 

 În caseta Sortare pe baza (Sort On) → Culoare celulă (Cell Color) 

 Caseta Ordine (Order) – culoarea de umplere după care se solicită ordonarea (se 

alege din listă) 
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 Sus/ Jos (On Top/ On Bottom) – ordinea de sortare (sus/ jos) 

o Sortarea după culoarea fonturilor → Sortare particularizată (Custom Sort) → în caseta 

de dialog Sortare (Sort) se precizează: 

 În caseta Sortare după (Sort By) – coloana criteriu de sortare 

 În caseta Sortare pe baza (Sort On) → Culoare font (Font Color) 

 Caseta Ordine (Order) – culoarea fontului după care se solicită ordonarea (se 

alege din listă) 

 Sus/ Jos (On Top/ On Bottom) – ordinea de sortare (sus/ jos) 

o Sortarea după pictograme  ( rezultate în urma Formatării Condiţionale, de exemplu: 

 sau ) → Sortare particularizată (Custom Sort) → în caseta de 

dialog Sortare (Sort) se precizează: 

 În caseta Sortare după (Sort By) – coloana criteriu de sortare 

 În caseta Sortare pe baza (Sort On) – Pictogramă celulă (Icon) 

 Caseta Ordine (Order) – pictograma după care se solicită ordonarea (se alege 

din listă) 

 Sus/ Jos (On Top/ On Bottom) – ordinea de sortare (sus/ jos) 

Opţiunile pentru sortare se accesează din butonul Opţiuni (Options) al casetei de dialog 

Sortare (Sort):  

 
 

 Sensibil la litere mari şi mici (Case sensitive) - se face diferenţiere în privinţa utilizării 

majusculelor şi minusculelor 

 Orientare (Orientation) – se va alege Sortare de sus în jos (Sort top to bottom) pentru tabele 

cu înregistrările organizate pe coloane şi cu primul rând antet şi se va alege Sortare de la 

stânga la dreapta (Sort left to right) pentru tabele cu înregistrările organizate pe rânduri şi cu 

prima coloană antet de tabel.

 

 Sortarea utilizând mai multe criterii (pe coloane diferite şi/sau pe aceeaşi coloană) 

Un nou criteriu de sortare va fi aplicat unui tabel doar pentru acelor înregistrări care, în urma 

aplicării criteriului anterior, au valori / culori / pictograme identice pe coloana criteriu de sortare. 

Se pot stabili mai multe criterii de sortare pentru un tabel astfel: 

1. Clic într-o celulă oarecare a tabelului 

2. Tabul Pornire → grupul Editare → butonul Sortare şi filtrare → Sortare particularizată 
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(Tabul Home → grupul Editing → butonul Sort & Filter → Custom Sort) → apare caseta de 

dialog Sortare (Sort) 

3. Se stabileşte primul criteriu de sortare, completând, aşa cum s-a prezentat anterior, casetele: 

Sortare după (Sort By), Sortare pe baza (Sort On), Ordine (Order), eventual Sus/ Jos (On 

Top/ On Bottom) şi opţiuni 

4. Se adaugă un nou criteriu de sortare prin acţionarea butonului Adăugare nivel (Add Level) 

 şi i se completează corespunzător rubricile 

Se reordonează nivelurile de sortare din butoanele   Mutare în sus (Move Up) şi 

Mutare în jos (Move Down). 

Se elimină un nivel (criteriu) de sortare cu butonul Ştergere nivel (Delete Level) 

 
 

Observaţii:  Pentru un tabel definit ca Table, toate operaţiile privind sortarea pot fi accesate prin 

deschiderea butoanelor de filtrare ale coloanelor. 

Operaţiile de sortare pot fi accesate şi din tabul Date → grupul Sortare şi filtrare (tabul 

Data → grupul Sort & Filter) → butoanele Sortare de la A la Z (Sort A to Z), Sortare de 

la Z la A (Sort Z to A) şi Sortare (Sort).  

 

Exemplu:  

       

Rezultă: 

  

Tabel sortat pe câmpurile: 

Departament – Ascendent 

Funcţia - Descendent 

Salariu – Ascendent 

Vechimea – Pictograma  Sus 

(On Top) 

 



 

 

 

Ministerul Comunicaţiilor şi Societăţii Informaţionale                          Proiectul Economia bazată pe Cunoaştere 
 

 

Componenta proiect: „Extinderea accesului la tehnologiile ITC şi îmbunătăţirea cunoştinţelor de utilizare a calculatorului” 

Program de formare continuă: „Utilizarea calculatorului personal: aplicarea TIC în şcoală şi afaceri” 

Suport de curs pentru Modulul: „Bazele utilizării aplicaţiilor de calcul tabelar; aplicaţia EXCEL din Microsoft Office” 

Pag. 57 

 

4.7.2. Filtrarea automată a datelor  

Filtrarea reprezintă afişarea dintr-un tabel tip bază de date doar a acelor înregistrări care se supun 

unuia sau mai multor criterii de filtrare. O operaţie de filtrare nu reorganizează înregistrările (mutări 

sau sortări), ci doar le afişează pe acelea care îndeplinesc condiţia precizată. 

Filtrarea automată (AutoFilter) pune la dispoziţie un set prestabilit de criterii şi metode de 

filtrare. Acestea se stabilesc pentru una sau mai multe coloane prin deschiderea butoanelor de filtrare. 

Afişarea acestor butoane în partea dreaptă a fiecărei celule din antetul tabelului se obţine selectând 

orice celulă a tabelului şi folosind una din metodele: 

 Tabul Pornire → grupul Editare → butonul Sortare şi filtrare → Filtru (Tabul Home → 

grupul Editing → butonul Sort & Filter → Filter) 

 Tabul Date → grupul Sortare şi filtrare → butonul Filtru (Tabul Data → grupul Sort & 

Filter → butonul Filter) 

 Declararea tabelului ca Tabel Excel (Table) cu tabul Inserare → grupul Tabele → butonul 

Tabel (tabul Insert → grupul Tables → butonul Table) 

În partea dreaptă a fiecărei celule din antetul tabelului apar butoanele de filtrare, care permit 

stabilirea criteriilor de filtrare.  

 

 
 

Se deschide butonul de filtrare al coloanei criteriu de filtrare şi se poate opta pentru una din 

variantele: 

Observaţie: Indiferent de varianta de filtrare aleasă, se va reveni la afişarea întregului tabel alegând: 

o Din lista butonului de filtrare al coloanei pe care s-a stabilit un filtru → opţiunea 

Selectare totală (Select  All)  sau  Golire filtru de la… Clear Filter From ... sau 

o Clic oriunde în tabel şi, din tabul Date → grupul Sortare şi filtrare (tabul Data → 

grupul Sort & Filter) → butonul  Golire (Clear)  . 

 Filtrare prin selecţie: din lista butonului de filtrare se selectează una sau mai multe dintre valorile 

afişate. Aceasta va duce la ascunderea tuturor liniilor ce nu conţin pe respectiva coloană 

valoarea/valorile selectate. 
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Exemplu: afişarea doar a clienţilor din Bucureşti, sau doar a clienţilor din Bucureşti şi Iaşi. 

      

 Filtrare cu operator de comparaţie: în funcţie de natura informaţiilor conţinute în coloana 

criteriu de filtrare, după deschiderea butonului de filtrare se poate alege una din variantele Filtre de 

text (Text Filters) - pentru şiruri de caractere, Filtre de număr (Number Filters) - pentru valori 

numerice sau Filtre Dată (Date Filters) - pentru date calendaristice, fiecare  astfel de comandă 

deschizând o listă cu termeni de comparaţie specifici ce pot fi utilizaţi în construirea criteriului de 

filtrare.  

 
 

În multe situaţii, alegerea termenului de comparaţie duce la deschiderea casetei de dialog 

Filtrare automată particularizată (Custom AutoFilter) , unde se precizează valorile de comparaţie. 

 

Exemple: 

Afişarea doar a clienţilor a căror adresă începe cu litera „V”; 

Afişarea doar a facturilor cu valoare mai mică decât 5000000; 

Afişarea doar a facturilor a căror valoare depăşeşte media aritmetică a valorilor; 

Afişarea doar a facturilor emise în Trimestrul 3. 

Pentru valorile de tip numeric se poate realiza şi filtrarea de tip clasament dacă din lista 

termenilor de comparaţie se selectează opţiunea Primele 10 (Top 10). Această opţiune permite afişarea 

unui număr de înregistrări (10, mai multe sau mai puţine), cele mai mari Sus (Top) sau cele mai mici 

Jos (Bottom) din coloana aleasă drept criteriu de filtrare. Acest tip de filtrare nu va face şi sortarea 
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înregistrărilor în funcţie de criteriul ales. 

 
 

Exemplu: afişarea celor mai mici (ca valoare) 6 articole (facturi).  

 Filtrarea particularizată (Custom Filter) se face alegând din lista termenilor de comparaţie a 

opţiunii de filtrare Filtru particularizat (Custom Filter), ceea ce conduce la deschiderea casetei de 

dialog Filtru automat particularizat (Custom AutoFilter), unde se construieşte criteriul de filtrare. 

 

Exemplu: afişarea facturilor cu valori > 5000000 şi a acelora cu valori < 10000. 

 

Observaţie: mai multe criterii de filtrare (condiţii) pe aceeaşi coloană se leagă între ele prin operatorii 

logici şi (AND) sau (OR). 

Pot fi stabilite criterii de filtrare pe mai multe coloane simultan într-un tabel tip bază de date, 

stabilindu-se restricţiile pentru fiecare coloană în parte. 

 

Exemplu:  afişarea doar a acelor facturi emise către clienţii din Bucureşti, plătite şi cu valoarea 

> 5000000 

 

Este permisă şi filtrarea în funcţie de culoare (a celulelor, a fonturilor, a pictogramelor) prin 

alegerea din lista butonului de filtrare a opţiunii Filtrare după culoare (Filter By Color) şi alegând în 

continuare culoarea de umplere, de font, sau pictograma dorită. 

Dezactivarea filtrării automate, eliminarea butoanelor de filtrare şi afişarea liniilor care eventual 

au rămas ascunse în urma unui filtru se face cu clic oriunde în tabel procedând în una din variantele: 

 Tabul Pornire → grupul Editare → butonul Sortare şi filtrare → Filtru (Tabul Home → 

grupul Editing → butonul Sort & Filter → Filter) - pentru dezactivare 

 Tabul Date → grupul Sortare şi filtrare → butonul Filtru (Tabul Data → grupul Sort & 

Filter → butonul Filter) - pentru dezactivare 

 Dacă tabelul a fost definit ca Table, atunci se poate şi: tabul Proiectare →  grupul 

Instrumente → comanda Convertire la interval (tabul Design → grupul Tools → comanda 

Convert to Range) 
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4.7.3. Subtotaluri 

Opţiunea de Subtotal permite aplicarea de diverse funcţii de rezumare pe grupuri constituite într-

un tabel tip bază de date.  

Exemplu: Într-un tabel ca cel de mai jos se doreşte aflarea valorii totale a facturilor emise, pe fiecare 

localitate în parte.  

O condiţie pentru a aplica subtotalul este aceea ca tabelul să fie sortat pe câmpul ce constituie 

criteriu de grupare (în exemplul acesta: localitate). 

Se începe deci prin sortarea tabelului, apoi, clic oriunde în tabel şi, din tabul Date → grupul 

Schiţă → butonul Subtotaluri (tabul Data → grupul Outline → butonul Subtotal), ceea ce conduce la 

apariţia casetei de dialog Subtotal, unde se precizează: 

 

  
 

 
 

 La fiecare modificare în (At each change in)  → câmpul de grupare, sau numele coloanei în 

funcţie de care se vor subtotaliza datele (ex: Localitate) 

 Utilizare funcţie (Use function) → funcţia de rezumare (Sumă (Sum), Min, Max, Medie 

(Average), etc.) 

 Adăugare subtotal la (Add subtotal to) → coloana/coloanele ale cărei/căror valori vor fi 

subtotalizate şi totalizate (ex: Valoare) 

Opţiunile casetei de dialog permit: 

 Înlocuire subtotaluri curente (Replace current subtotals) → înlocuirea subtotalurilor curente 

 Sfârşit de pagină între grupuri (Page break between groups) → inserarea unui sfârşit de 

pagină după fiecare grup subtotalizat 

 Însumare sub date (Summary below data) → amplasarea sumarului sub informaţiile sursă 

 Butonul Eliminare totală (Remove All) → permite eliminarea subtotalurilor 
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Pot fi adăugate mai multe subtotaluri unui tabel, folosind diferite funcţii rezumative. 

După obţinerea subtotalurilor, în zona din stânga foii de calcul apare o bară ce conţine butoane 

 şi . Butoanele  permit restrângerea detalierii subtotalurilor, astfel încât să de obţină o structură 

a tabelului. Butoanele  reafişează liniile cu detalii.  

 Dacă se creează o diagramă din datele unui tabel ce conţine subtotaluri, aceasta se va modifica 

şi actualiza la afişarea/restrângerea detalierilor. 

 Eliminarea subtotalurilor se face dând clic oriunde în tabel → tabul Date → grupul Schiţă → 

butonul Subtotaluri →  Eliminare totală (tabul Data → grupul Outline → butonul Subtotal → 

Remove All). 

 

 

Ce aţi învăţat în acest capitol ? 

 Cum poate fi definit un tabel tip listă ca Excel Table 

 Cum pot fi ordonate înregistrările unui tabel având drept criteriu valorile sau 

culorile uneia sau mai multor coloane (Sortarea) 

 Cum se pot afişa dintr-un tabel doar acele înregistrări care întrunesc una sau mai 

multe condiţii (Filtrarea) 

 Cum se aplică funcţii rezumative pe grupuri în cadrul unei tabel (Subtotal) 

 

4.8. Diagrame 

4.8.1. Realizarea unei diagrame 

Diagrama este definită ca reprezentarea grafică a datelor de tip numeric dintr-un tabel.  

Pentru realizarea unei diagrame se selectează acele blocuri de celule din tabel care vor fi 

reprezentate grafic (inclusiv celulele corespunzătoare din capul de tabel şi eventualele celule cu text 

explicativ), apoi tabul Inserare → grupul Diagrame (tabul  Insert → grupul Charts) 

 

şi se alege tipul diagramei cu clic pe pictograma corespunzătoare (Coloană (Column), Bară (Bar), 

Radială (Pie), etc.), ceea ce duce la deschiderea listei cu subtipurile aferente; se selectează subtipul 

dorit cu clic pe el. 

Observaţii:  1)   alegerea tipului şi a subtipului de diagramă se poate face şi din caseta de dialog 
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Inserare diagramă (Insert Chart), casetă care se deschide la comanda 

 Toate tipurile de diagrame (All Chart Types) din lista 

oricărui buton cu tipuri de diagrame sau la clic pe butonul din colţul dreapta jos al 

grupului Diagrame (Charts). 

 

Caseta de dialog Inserare diagramă (Insert Chart) conţine, în panoul din stânga, lista 

tipurilor de diagrame, iar în panoul din dreapta, subtipurile disponibile. 

2)  În situaţia în care utilizatorul foloseşte frecvent un anumit tip şi subtip de diagramă, 

acesta poate fi definit ca tip/subtip implicit prin acţionarea butonului Setare ca 

diagramă implicită (Set as Default Chart), ceea ce va face ca, la deschiderea 

ulterioară a casetei de dialog Inserare diagramă  (Insert Chart), să apară selectat în 

mod implicit respectivul subtip. 

În urma acestei comenzi, diagrama apare ca obiect în foaia de calcul. Pentru a realiza operaţii de 

tip redimensionare, copiere, mutare, ştergere, se selectează diagrama cu clic pe ea, apoi: 

 Redimensionare – prin glisarea de unul din cei opt marcatori de pe marginile diagramei; 

 Mutare/copiere – prin glisarea de o margine a diagramei (mutare) sau prin glisarea de o 

margine a diagramei ţinând tasta Ctrl apăsată (copiere); sau utilizând comenzile de 

mutare/copiere cunoscute; 

 Ştergere – prin apăsarea tastei Delete. 

La selectarea unei diagrame din foaia de calcul se constată: 

- Datele sursă ale diagramei apar marcate (înconjurate în chenare) 

- În panglica (ribbon) aplicaţiei devin disponibile instrumentele de lucru cu diagramele 

Instrumente diagramă (Chart Tools), prin afişarea taburilor Proiectare (Design), Aspect 

(Layout) şi Format. 

 

4.8.2. Editarea diagramei 

Pentru a modifica o diagramă sau diversele ei componente, este necesară selectarea acesteia cu 

clic pe ea, după care se utilizează instrumentele de lucru cu diagramele - tabul Instrumente diagramă 

(Chart Tools), si anume opţiunile puse la dispoziţie de taburile Proiectare (Design), Aspect (Layout) şi 

Format. 
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Tabul Proiectare (Design) permite realizarea următoarelor operaţii: 

 

 Schimbarea tipului şi subtipului diagramei: grupul Tip → butonul Modificare tip diagramă 

(grupul Type → butonul Change Chart Type) 

Apare caseta de dialog Modificare tip diagramă (Change Chart Type), de unde se selectează tipul 

şi subtipul de diagramă dorit. 

 Salvarea unei diagrame ca şablon: grupul Tip → butonul Salvare ca şablon (grupul Type → 

butonul Save as Template) 

- Salvarea unui nou şablon - se va face în dosarul cu Şabloane de diagramă (Chart Templates), 

alocând un nume noului şablon (fişier cu extensia .crtx) 

- Aplicarea unui şablon de diagrame - şabloanele astfel create vor putea fi accesate pentru a fi 

utilizate la crearea unui grafic nou sau modificarea unuia existent din folderul Şabloane 

(Templates) al casetelor de dialog cu tipuri de diagrame 

- Ştergerea unui şablon – tabul Inserare → clic pe butonul Creare diagramă (tabul Insert →  

butonul Create Chart) din colţul dreapta jos al grupului Diagrame (Charts) → clic pe butonul 

Gestionare şabloane Manage Templates → se deschide folderul cu şabloane de diagrame, de 

unde se şterge fişierul şablonului de şters 

 Comutarea între afişarea în diagramă a seriilor pe rânduri sau pe coloane: grupul Date →  

butonul Comutare rând/coloană (grupul Data → butonul Switch Row/Column) 

În urma unei astfel de comenzi, datele reprezentate pe axa X vor fi trecute pe axa Y şi vice-versa. 

 Modificarea datelor sursă ale diagramei: grupul Date → butonul Selectare date (grupul Data → 

butonul Select Data) 

   

Caseta de dialog Selectare sursă de date (Select Data Source) deţine următoarele opţiuni: 

- Caseta Interval date diagramă (Change Data Sourse): vizualizarea blocurilor de date sursă şi 

modificarea acestora (prin tastarea referinţelor sau prin selectare din foaia de calcul) 

- Caseta Intrări legendă (Serial) (Legend Entries (Series)) conţine lista seriilor de date 

reprezentate grafic 
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 Butonul Adăugare (Add) - adăugarea unei serii de date → apare caseta de dialog Editare 

serie (Edit Series), unde, în caseta Nume serie (Series Name) se indică adresa celulei antet de 

coloană (numele seriei), iar în caseta Valori în serie (Series Values) se indică adresa valorilor 

ce vor fi reprezentate grafic 

 Butonul Editare (Edit) → modificarea numelui sau a valorilor seriei de date selectate, în 

caseta de dialog Editare serie (Edit Series) 

 Butonul Eliminare (Remove) → eliminarea unei serii de date din diagramă 

 Butoanele Mutare în sus (Move Up) şi Mutare în jos (Move Down) → reordonarea seriilor 

de date reprezentate 

- Caseta Etichete axă orizontală (categorie) (Horizontal (Category) Axes Labels) afişează 

etichetele ce vor fi dispuse pe axa orizontală, iar modificarea acestora se poate face din butonul 

Editare (Edit). 

 

- Butonul Celule ascunse şi goale (Hidden and Empty Cells) → permite stabilirea modului de 

reprezentare al datelor ascunse şi a valorilor nule. 

 Aplicarea unei scheme predefinite de dispunere a elementelor diagramei: una dintre schemele 

(Layout-urile) grupului Aspecte de diagramă (Chart Layouts). 

 

Aceste scheme de aspect (Layout-uri) deţin variante predefinite de afişare, amplasare şi aspect ale 

diverselor elemente din componenţa diagramei (titluri de diagramă şi de axe, legendă, etichete de 

date, tabel de date, etc.). Aplicarea unei astfel de scheme se face selectând-o din lista grupului 

Aspecte de diagramă (Chart Layouts). 

 Modificarea stilului diagramei: butoanele din lista grupului Stiluri de diagramă (Chart Styles) 

 

Un stil conţine opţiuni predefinite de formatare pentru toate elementele diagramei (fonturi, culori, 

stiluri de linii, efecte, alinieri, etc.). 

Observaţie:  dacă fereastra aplicaţiei Excel nu este maximizată, grupurile Aspecte diagramă (Chart 

Layouts) şi Stiluri diagramă (Chart Styles) nu afişează listele cu schemele de dispunere, 
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respectiv de stiluri, ci butoanele Aspect rapid (Quick Layout) şi Stiluri rapide (Quick 

Styles), care deschid respectivele liste. 

 

 Schimbarea amplasamentului diagramei: grupul Locaţie → butonul Mutare diagramă (grupul 

Location → butonul Move Chart) 

 

Diagrama va putea fi plasată pe o foaie specială pentru diagramă Foaie nouă: (New sheet:), ce se 

va poziţiona automat în faţa foii cu datele din care s-a trasat diagrama şi va avea numele implicit 

Diagramă 1 (Chart 1) sau ca obiect într-o foaie de calcul Obiect în: (Object in:). 

 

Tabul Aspect (Layout) permite realizarea următoarelor operaţii: 

 
 

 Selectarea diverselor elemente componente ale diagramei: grupul Selecţie curentă → lista 

butonului Elemente diagramă (grupul Current Selection → lista butonului Chart Elements) 

 Formatarea unui element selectat: grupul Selecţie curentă →butonul Formatare selecţie (grupul 

Current Selection → Format Selection) → apare caseta de dialog Formatare… (Format…), ce 

permite stabilirea opţiunilor de formatare ale elementului selectat 

 

 Revenirea elementului selectat la formatarea implicită: grupul Selecţie curentă → butonul 

Reiniţializare pentru potrivire stil (grupul Current Selection → butonul Reset to Match Style) şi se 

va reveni la formatarea impusă de stilul diagramei 

 Inserarea de imagini, forme desenate şi casete de text pe diagramă: grupul Inserare → 

butoanele Imagine, Forme şi Casetă text (grupul Insert → butoanele Picture, Shapes, Text Box) 

 Adăugarea/eliminarea, amplasarea şi formatarea diverselor etichete pe diagramă → grupul 

Etichete (Labels)→ butoanele:  
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- Titlu Diagramă (Chart Title) – titlul diagramei 

- Titluri de axe  (Axis Title) – titluri pentru axele verticale şi orizontale 

- Legendă  (Legend) – legenda diagramei 

- Etichete de date  (Data Labels) – etichete de date (categorii, valori, procentaje) 

- Tabel de date  (Data Table) – tabelul cu datele sursă ale diagramei 

Fiecare dintre aceste butoane deschide o listă de opţiuni privind opţiunile de afişare ale 

respectivului tip de etichetă (amplasare, aliniere, dimensionare, etc.), iar comenzile de tip Mai 

multe opţiuni pentru… (More ... Options) deschid casete de dialog de tip Format… (Format ...) , 

cu opţiuni de formatare a respectivelor etichete.  

 Adăugarea/eliminarea, poziţionarea, scalarea, formatarea informaţiilor pe axe: grupul Axe → 

butonul Axe (grupul Axes → butonul Axes) 

 Adăugarea/eliminarea liniilor de grilă pe diagramă: grupul Axe → butonul Linii de grilă 

(grupul Axes → butonul Gridlines) 

 Modificarea aspectului elementelor de fundal ale diagramei: butoanele grupului Fundal 

(Background) 

 

Tabul Format permite realizarea următoarelor operaţii: 

 
 

 Formatarea cu un stil de formă predefinit (Shape Style) a oricărui element component 

selectat al diagramei: grupul Shape Styles (Stiluri de forme)→ se alege unul dintre stilurile din 

listă 

 

Un stil de formă conţine formatări de tipul: culoare şi efecte de umplere, culoare, grosime, efecte 

linii de chenar, fonturi, etc.). 

 Formatarea elementelor componente ale diagramei: grupul Stiluri de forme (Shape Style) → 
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butoanele: 

- Umplere formă (Shape Fill) → culori/efecte de umplere 

- Contur formă (Shape Outline) → culori/grosimi linii de contur 

- Efecte formă (Shape Effects) → efecte de tip umbrire, rotire, reflexie 

 Aplicarea de efecte textelor din diversele casete ale diagramei: grupul Stiluri WordArt 

(WordArt Styles) → se alege un stil predefinit din listă sau se formatează textele elementelor 

selectate cu butoanele: 

 

- Umplere text (Text Fill) → culoarea de umplere a literei 

- Schiţa text (Text Outline) → culoarea de chenar a literei 

- Efecte text (Text Effects) → diverse efecte ce pot fi aplicate textelor 

 Redimensionarea suprafeţei diagramei: grupul Dimensiune →  casetele Înălţime formă şi 

Lăţime formă (grupul Size → casetele Shape Height şi Shape Width) 

 

Observaţie: Unei diagrame i se pot aduce modificări de structură şi de formatare ale diverselor 

componente şi din meniurile contextuale ale acestora (clic dreapta), alegând diversele 

comenzi disponibile.  

 
 

 

Ce aţi învăţat în acest capitol ? 

 Cum se realizează o diagramă  

 Cum se copiază, mută sau şterge o diagramă 

 Cum se modifică o diagramă 

 

 

4.9. Vizualizarea şi formatarea foii de calcul şi a registrului 

4.9.1. Modurile de vizualizare a foii de calcul 

Schimbarea dimensiunii de vizualizare a documentului se realizează din caseta de dialog 

Panoramare (Zoom), casetă ce se deschide la una din comenzile: 

- Tabul Panoramare → butonul Panoramare  (tabul View → butonul Zoom) 

- Clic pe factorul de scalare în partea dreaptă a barei de stare 
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sau direct în bara de stare, prin glisarea cursorului factorului de scalare. 

 

Pot fi alese diferite procente de vizualizare prestabilite sau una din variantele: 

 Potrivire selecţie (Fit Selection), care redimensionează afişarea la lăţimea zonei de celule 

selectate (pentru aceeaşi operaţie: tabul Vizualizare (View) → grupul Panoramare (Zoom) → 

butonul Panoramare la selecţie (Zoom to Selection)) 

 Particularizare (Custom) - se poate completa cu un procent de dimensionare a vizualizării 

 

4.9.1.1. Modul de vizualizare Aspect pagină  

Modul de vizualizare Aspect pagină (Page Layout) se accesează astfel: 

- Tabul Vizualizare → grupul Vizualizări registre de lucru → butonul Aspect pagină  

(tabul View → grupul Workbook Views → butonul Page Layout) 

- Butonul Aspect pagină ( Page Layout) din bara de stare a aplicaţiei . 

Acest mod de vizualizare este util în pregătirea foii de calcul pentru imprimare. Permite editarea 

informaţiilor, şi, în plus faţă de operaţiile specifice modului Normal de vizualizare, în Aspect pagină 

(Page Layout) se mai pot realiza: 

 Examinarea împărţirii pe pagini a conţinutului foii de calcul 

 Utilizarea riglelor pentru măsurarea lăţimii şi înălţimii informaţiei conţinute în pagină 

 Modificarea orientării paginii 

 Adăugarea şi modificarea antetului şi a subsolului 

 Stabilirea marginilor paginii 

 Ascunderea/afişarea antetelor de rând şi de coloană şi a grilelor foii de calcul 
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Observaţii:  În mod implicit, acest mod de vizualizare afişează antetele de rând şi de coloană, însă, 

dacă nu se operează alte modificări în acest sens, aceste elemente nu vor fi vizibile pe 

pagina imprimată. 

Vizualizarea foilor de calcul exact aşa cum vor apărea la imprimare se face cu ajutorul 

modului de vizualizare Examinare înaintea imprimării (Print Preview). 

Operaţii specifice modului de vizualizare Aspect pagină (Page Layout) 

 Utilizarea riglelor 

Modul de vizualizare Aspect pagină (Page Layout) afişează o riglă orizontală şi una verticală, ce 

permit măsurarea cu precizie a celulelor, blocurilor de celule, a obiectelor sau a marginilor paginii. 

Marginile sus, jos, stânga, dreapta ale paginii pot fi ajustate prin glisare cu mausul. 

Ascunderea/reafişarea riglelor se face în acest mod de vizualizare din tabul Vizualizare (View) 

→ grupul Afişare/ Ascundere (Show/ Hide) → debifare/bifare Riglă (Ruler). 

 Crearea şi modificarea zonelor de antet şi subsol 

Antetul şi subsolul pot fi create în modul de vizualizare Aspect pagină (Page Layout) dând clic 

şi introducând informaţiile în casetele de substituţie Faceţi clic pentru a adăuga un antet (Click to 

add header) şi Faceţi clic pentru a adăuga un subsol (Click to add Footer), şi tot în aceste casete se 

pot realiza şi modificările. 

 

 Ascunderea / afişarea grilelor foii de calcul şi a antetelor de rând şi de coloană 

Aceste elemente sunt implicit afişate în modul de vizualizare Aspect pagină (Page Layout) (nu 

vor fi şi tipărite automat). Ascunderea/afişarea acestor elemente se face prin debifare/bifare a 

opţiunilor Linii de grilă (Gridlines) şi Titluri (Headings) din tabul Vizualizare →  grupul 

Afişare/Ascundere (tabul View → grupul Show/Hide). 
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 Revenirea la modul de vizualizare Normal 

Tabul Vizualizare (View) → grupul Vizualizări registre de lucru (Workbook Views) → butonul 

Normal  sau clic în bara de stare pe butonul (Normal) . 

 

4.9.1.2. Modul de vizualizare Examinare înaintea imprimării  

Modul de vizualizare  Examinare înaintea imprimării (Print Preview) se accesează din: 

Butonul Buton Office → Imprimare → Examinare înaintea imprimării (Office Button → Print 

→ Print Preview) sau combinaţia de taste Ctrl + F2 

În urma executării acestei comenzi va apărea fereastra corespunzătoare reprezentată în figură: 

 

 
 

Acest mod de vizualizare permite examinarea foii de calcul exact aşa cum va apărea aceasta la 

imprimantă. 

Semnificaţia butoanelor tabului Examinare înaintea imprimării (Print Preview) este: 

 
- Imprimare (Print)  - lansează comanda de tipărire 

- Iniţializare pagină (Page Setup) - deschiderea casetei de dialog pentru formatarea paginii  

- Panoramare (Zoom) - modificarea dimensiunii de vizualizare (bara de stare se va afişa 

Micşorare (Zoom In), respectiv Mărire (Zoom Out)) 

- Pagina următoare (Next Page) - navigare către pagina următoare a foii de calcul 

- Pagina anterioară (Previous Page) - navigare către pagina anterioară a foii de calcul 

- Afişare margini (Show Margins)– afişează marginile paginii, care pot fi ajustate prin glisare 

-  Închidere Examinare înaintea imprimării (Close Print Preview) - revenirea în modul de 

vizualizare Normal (echivalent cu utilizarea tastei Esc) 
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Modul de vizualizare Examinare înaintea imprimării (Print Preview) nu permite editarea 

informaţiilor din document. 

 

4.9.1.3. Modul de vizualizare Examinare sfârşit de pagină  

Accesarea acestui mod de vizualizare se face alegând: tabul Vizualizare → grupul Vizualizări 

registre de lucru →  butonul Examinare sfârşit de pagină (tabul View → grupul Workbook Views → 

butonul Page Break Preview). 

Acest mod de vizualizare al documentului afişează delimitarea şi modul de succedare al 

paginilor din care este formată foaia de calcul curentă. Trecerea pe la o pagină la alta poartă numele de 

Sfârşit de pagină (Page Break). Sfârşiturile de pagină automate (create de aplicaţie) apar ca linii 

punctate, iar cele create manual ca linii continue. În privinţa dispunerii în pagină a informaţiilor 

conţinute în foaia de calcul, acest mod de vizualizare permite: 

 
 

 Ajustarea sfârşiturilor de pagină  

Se obţine prin glisarea mausul a sfârşiturilor de pagină. Ajustarea unui sfârşit de pagină automat 

va face ca acesta să devină de tip manual. 

 Inserarea de noi sfârşituri de pagină 

Pentru a insera un sfârşit de pagină vertical sau orizontal, se selectează rândul sau coloana de 

dedesubtul sau din dreapta locului de inserare → clic dreapta → Inserare sfârşit de pagină (Insert 

Page Break) din meniul de context  

 Eliminarea unui sfârşit de pagină creat manual  

Pentru a şterge un sfârşit de pagină vertical sau orizontal, se selectează o celulă aflată la dreapta 

sau dedesubtul sfârşitului ce va fi şters  → clic dreapta → Eliminare sfârşit de pagină (Remove Page 

Break) din meniul de context 

 

 Eliminarea tuturor sfârşiturilor de pagină manuale 

Se execută clic dreapta în orice celulă a foii de calcul → Reiniţializarea tuturor sfârşiturilor de 

pagină (Reset All Page Breaks) din meniul de context şi se revine la împărţirea automată pe pagini. 

Observaţie:  Operaţiile de inserare şi eliminare a întreruperilor de pagină pot fi executate şi în modul 

de vizualizare Normal, utilizând: tabul Aspect pagină → butonul Întreruperi (tabul Page 

Layout → butonul Breaks) → alegând una dintre comenzile Inserare sfârşit de pagină 
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(Insert Page Break), Eliminare sfârşit de pagină (Remove Page Break) sau 

Reiniţializarea tuturor sfârşiturilor de pagină (Reset All Page Breaks), în funcţie de 

situaţie. 

 
 
 

 Revenirea la modul de vizualizare Normal 

Tabul Vizualizare → grupul Vizualizări registre de lucru (Tabul View → grupul Workbook 

Views) → butonul Normal, sau clic în bara de stare pe butonul Normal . 

Sfârşiturile de pagină sunt vizibile şi în modul Normal de vizualizare după revenirea din Aspect 

pagină (Page Layout), Examinare înaintea imprimării (Print Preview) sau Examinare sfârşit de 

pagină (Page Break Preview).  

 

4.9.2. Opţiuni de vizualizare 

4.9.2.1. Deschiderea unui registru în mai multe ferestre 

Pentru a putea vizualiza simultan două sau mai multe foi de calcul ale unui registru, acesta poate 

fi deschis în mai multe ferestre astfel:  

1. Tabul Vizualizare → grupul Fereastră → butonul Fereastră nouă (Tabul View → grupul 

Window → butonul New Window). În taskbar va apărea, pe lângă butonul de minimizare al 

registrului deschis, un nou buton, cu acelaşi nume, doar că unul are denumirea urmată de (:1), 

iar celălalt de (:2).  

 

2. Pentru a aranja ambele ferestre ale registrului pe ecran: tabul Vizualizare → grupul Fereastră 

→ butonul Aranjare totală (tabul View → grupul Window → butonul Arrange All)şi, în 

caseta de dialog Aranjare ferestre (Arrange Window), se alege opţiunea potrivită (de 

exemplu Verticală). În fiecare dintre cele două ferestre va putea fi activă o altă foaie de 

calcul. 

După închiderea uneia dintre ferestre, cealaltă poate fi reafişată pe întreg ecranul prin 

maximizare. 
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4.9.2.2. Îngheţarea panourilor (Freeze Panes)  

Opţiunea de îngheţare (blocare) în derulare permite ca anumite zone ale foii de calcul să rămână 

vizibile la defilarea prin foaie, de exemplu menţinerea vizibilă pe ecran a unui cap de tabel sau a unei 

coloane cu etichete.  

 Îngheţarea (blocarea în derulare) unui panou: 

- Un rând şi zona de deasupra sa: se selectează prima celulă de sub rândul ce va fi blocat 

- O coloană şi zona din stânga sa: se selectează prima celula din dreapta coloanei ce va fi 

blocată 

- Un rând şi o coloană şi zonele de deasupra, respectiv din stânga: se selectează celula de 

dedesubtul, respectiv din dreapta rândului/ coloanei 

apoi, tabul Vizualizare →  grupul Fereastră →  butonul Îngheţare panouri →  comanda 

Îngheţare panouri (tabul View → grupul Window → butonul Freeze Panes → comanda Freeze 

Panes) 

 Îngheţarea (blocarea în derulare) primului rând al foii de calcul 

Tabul Vizualizare → grupul Fereastră → butonul Îngheţare panouri → comanda Blocare rând 

de sus 

(Tabul View → grupul Window → butonul Freeze Panes → comanda Freeze Top Row) 

 Îngheţarea (blocarea în derulare) primei coloane a foii de calcul 

Tabul Vizualizare → grupul Fereastră → butonul Îngheţare panouri → comanda Îngheţare 

prima coloană 

(Tabul View → grupul Window → butonul Freeze Panes → comanda Freeze First Column) 

 Renunţarea la îngheţarea unui panou  

Tabul Vizualizare → grupul Fereastră → butonul Îngheţare panouri → comanda Anulare 

îngheţare panouri 

(Tabul View → grupul Window → butonul Freeze Panes → comanda Unfreeze Panes) 

 

4.9.2.3. Scindarea foii de calcul în panouri (Split) 

Pentru a vizualiza concomitent două zone îndepărtate ale unei foi de calcul, aceasta poate fi 

împărţită în panouri ce permit navigarea independentă. Pentru aceasta, se selectează celula ce va marca 

locul de divizare, apoi tabul Vizualizare → grupul Fereastră → butonul Scindare (tabul View → 

grupul Window →  butonul Split). Foaia de calcul va fi împărţită în 2 sau 4 panouri cu propriile bare 

de defilare (scrollbars), iar, dacă este necesar, barele de demarcaţie pot fi deplasate prin glisare cu 

mausul pentru a schimba locul de divizare.  

Renunţarea la opţiunea de scindare se face prin dezactivarea butonului Scindare (Split) al 

grupului Fereastră (Window).  
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4.9.3. Formatarea documentului 

Stabilirea caracteristicilor de formatare ale tuturor paginilor registrului sau ale tuturor paginilor 

unei foi de calcul se realizează cu opţiunile tabului Aspect pagină (Page Layout). 

4.9.3.1. Aplicarea temelor de document 

Pentru a conferi un aspect unitar tuturor paginilor registrului, acesta poate fi formatat prin 

asocierea unei Teme (Theme). O temă reprezintă un set unitar de elemente de design şi conţine 

formatări legate de culori de umplere, fonturi, linii (chenare) şi efecte de umplere.  

Observaţie:  Caracteristicile de formatare ale unei teme vor fi preluate în documentul curent doar de 

acele elemente (celule, tabele – Excel Tables, diagrame, etc.) cărora nu li s-au adus în 

prealabil modificări individuale în privinţa aspectelor controlate de teme (fonturi, culori, 

liniatură, efecte).  

 Aplicarea unei teme predefinite 

Tabul Aspect pagină → grupul Teme → butonul Teme (Tabul Page Layout → grupul Themes 

→ butonul Themes)→ se alege una dintre temele din listă. 

 

Aplicarea unei teme predefinite va afecta automat stilurile utilizate în document (stiluri de celulă, 

de tabel, de diagramă), modificând aspectul elementelor ce conţineau respectivele stiluri. 

 Particularizarea unei teme de document 

Particularizarea unei teme presupune modificarea unor aspecte de formatare conţinute de aceasta, 

şi anume: culori, fonturi, liniaturi, efecte ale fonturilor, ale celulelor, ale tabelelor, ale diagramelor, 

etc.. Modificările efectuate asupra oricărui astfel de aspect vor influenţa automat stilurile aplicate în 

document. 

 Particularizarea culorilor unei teme 

Tabul Aspect pagină → grupul Teme → butonul Culori (Tabul Page Layout → grupul Themes 

→ butonul Colors) → se alege o schemă coloristică predefinită. 

 Particularizarea fonturilor unei teme 

Tabul Aspect pagină → grupul Teme → butonul Fonturi (Tabul Page Layout → grupul Themes 

→ butonul Fonts) → se alege un alt font. 

 Particularizarea efectelor unei teme 

Tabul Aspect pagină → grupul Teme → butonul Efecte (Tabul Page Layout → grupul Themes 

→ butonul Effects) → se alege o altă schemă de liniaturi şi efecte de umplere. 
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4.9.3.2. Formatarea foilor de calcul 

Stabilirea caracteristicilor de formatare ale unei foi de calcul se poate realiza, în mare măsură, 

din diversele opţiuni puse la dispoziţie de butoanele de comandă ale tabului Aspect pagină (Page 

Layout) sau din caseta de dialog Iniţializare pagină (Page Setup). 

 

Caseta de dialog Iniţializare pagină (Page Setup) se poate afişa,  printre alte variante, cu clic pe 

butonul cu săgeată din colţul dreapta jos al oricăruia dintre grupurile Iniţializare pagină (Page Setup), 

Scalare pentru a se potrivi (Scale to Fit) sau Opţiuni de foaie (Sheet Options) ale tabului Aspect 

pagină (Page Layout). 

Caracteristicile de formatare ce pot fi asociate unei foi de calcul privesc următoarele aspecte: 

 

 Stabilirea marginilor paginii 

Se poate opta pentru una din variantele predefinite de configurare a marginilor de Sus (Top), Jos 

(Bottom), Stânga (Left), Dreapta (Right) ale paginii, şi anume Normal, Îngust (Narrow) sau Lat 

(Wide) din: 

Tabul Aspect pagină → grupul Iniţializare pagină → butonul Margini (tabul Page Layout → 

grupul Page Setup → butonul Margins) → se alege una dintre variantele predefinite: 

 

sau, pentru a defini margini particulare: 

Butonul Margini → Margini particularizate → în caseta de dialog Iniţializare pagină → fila 

Margini → se introduc dimensiunile în casetele Sus, Jos, Stânga şi Dreapta  

(Butonul Margins → Custom margins → în caseta de dialog Page Setup → fila Margins → se 

introduc dimensiunile în casetele Top, Bottom, Left şi Right) 
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 Stabilirea orientării paginii 

Orientarea paginii poate fi verticală Portret (Portrait) sau orizontală  Vedere (Landscape), iar 

comutarea între cele două variante se face din: 

Tabul Aspect pagină → grupul Iniţializare pagină → butonul Orientare → Portret sau Vedere  

(Tabul Page Layout → grupul Page Setup → butonul Orientation → Portrait sau Landscape) 

 

sau 

Din caseta de dialog Iniţializare pagină → fila Pagină → rubrica Orientare (Page Setup → fila Page 

→ rubrica Orientation) 

 Stabilirea dimensiunii hârtiei 

Se poate opta pentru o dimensiune predefinită a hârtiei pe care se va face imprimarea din: 

Tabul Aspect pagină → grupul Iniţializare pagină → butonul Dimensiune (tabul Page Layout 

→ grupul Page Setup → butonul Size) → se alege o dimensiune predefinită 

sau, dând comanda Mai multe dimensiuni pagină (More Paper Sizes), se poate alege o dimensiune a 

hârtiei din: 

Caseta de dialog Iniţializare pagină → fila Pagină → lista casetei Dimensiune hârtie (caseta de 

dialog Page Setup → fila Page → lista casetei Paper Size). 

 Configurarea zonei de imprimare (Print Area) 

Stabilirea zonei de imprimare (Print Area) presupune indicarea celulelor din foaia de calcul care 

vor fi imprimate. Nedefinirea manuală a unor astfel de zone face ca aplicaţia Excel să stabilească 

automat zona de imprimat astfel încât aceasta să conţină toate celulele cu conţinut (care nu sunt goale) 

din foaia de calcul. Se definesc, extind, elimină zonele de imprimat astfel: 
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 Definirea celulei active sau a unei selecţii ca zonă de imprimare:  tabul Aspect pagină → 

grupul Iniţializare pagină → butonul Zonă de imprimare → comanda Stabilire zonă de 

imprimat (tabul Page Layout → grupul Page Setup → butonul Print Area → comanda Set 

Print Area) 

 Adăugarea selecţiei curente la zonele deja definite: tabul Aspect pagină → grupul Iniţializare 

pagină → butonul Zonă de imprimare → comanda Adăugare la zona de imprimat (tabul 

Page Layout → grupul Page Setup → butonul Print Area → comanda Add to Print Area) 

 Eliminarea zonelor de imprimare definite anterior → tabul Aspect pagină →  grupul 

Iniţializare pagină → butonul Zonă de imprimare → comanda Golire zonă de imprimat 

(tabul Page Layout → grupul Page Setup → butonul Print Area → comanda Clear Print 

Area) 

Zonele de imprimare pot fi definite, modificate sau eliminate şi din: 

Caseta de dialog Iniţializare pagină → fila Foaie → caseta Zonă de imprimat (caseta de dialog 

Page Setup → fila Sheet → caseta Print Area) 

 

 Stabilirea rândurilor şi/ sau a coloanelor ce se vor repeta pe fiecare pagină imprimată 

Pentru a stabili imprimarea la începutul fiecărei pagini tipărite a unuia sau mai multor rânduri 

(opţiune utilă pentru tabelele cu număr mare de linii): 

Tabul Aspect pagină → grupul Iniţializare pagină → butonul Imprimare titluri → apare caseta 

de dialog Iniţializare pagină → fila Foaie →  se specifică rândul/ rândurile în caseta Rânduri 

de repetat la început 

(Tabul Page Layout → grupul Page Setup → butonul Print Titles → apare caseta de dialog Page 

Setup → fila Sheet → se specifică rândul/ rândurile în caseta Rows to repeat at top) 

 

 

Pentru a stabili imprimarea în partea stângă a fiecărei pagini tipărite a uneia sau mai multor 

coloane (opţiune utilă pentru tabelele cu număr mare de coloane): 

Tabul Aspect pagină → grupul Iniţializare pagină → butonul Imprimare titluri → apare caseta 
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de dialog Iniţializare pagină → fila Foaie →  se specifică coloana/ coloanele în caseta Coloane 

de repetat la stânga 

(Tabul Page Layout → grupul Page Setup → butonul Print Titles → apare caseta de dialog Page 

Setup → fila Sheet → se specifică coloana/ coloanele în caseta Columns to repeat at left) 

 

 Fundalul foii de calcul 

Se poate opta pentru un fundal al foii de calcul constituit dintr-o imagine salvată într-un fişier 

astfel: 

Tabul Aspect pagină → grupul Iniţializare pagină → butonul Fundal (tabul Page Layout → 

grupul Page Setup → butonul Background) → în caseta de dialog Fundal foaie (Background) se 

selectează imaginea  

Renunţarea la fundalul unei foi de calcul se face cu: 

Tabul Aspect pagină → grupul Iniţializare pagină → butonul Ştergere fundal (tabul Page 

Layout → grupul Page Setup → butonul Delete Background) 

 

 Modalităţi de scalare a conţinutului foii de calcul 

Scalarea permite redimensionarea, ajustarea conţinutului foii de calcul sau al zonei de imprimat, 

pentru a se putea încadra într-un anumit număr de pagini.  

 

Se poate specifica un factor de scalare, exprimat ca procent, cu care să se facă ajustarea 

dimensiunii zonei de imprimat, din: 

Tabul Aspect pagină → grupul Scalare pentru a se potrivi → caseta Scară (tabul Page Layout 

→ grupul Scale to Fit → caseta Scale) → se modifică factorul de scalare 

Pentru a stabili numărul maxim de pagini pe orizontală - Lăţime (Width) şi/sau pe verticală - 

Înălţime (Height) pe care se va face tipărirea: 

Tabul Aspect pagină → grupul Scalare pentru a se potrivi → casetele Lăţime şi Înălţime (tabul 

Page Layout → grupul Scale to Fit → casetele Width şi Height), 

ceea ce va conduce la ajustarea corespunzătoare a factorului de scalare; nemodificarea celor două 

casete conduce la un factor de scalare de 100%. 

Observaţie:  Aceleaşi setări se pot face şi în caseta de dialog Iniţializare pagină → fila Pagină → 

rubrica Scalare → opţiunile Ajustare la, respectiv Potrivire la (caseta de dialog Page 

Setup → fila Page → rubrica Scaling → opţiunile Adjust to, respectiv Fit to). 
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 Imprimarea grilelor foii de calcul şi a titlurilor de rând şi de coloană 

În mod implicit, aceste elemente nu se tipăresc. Pentru a le face vizibile la imprimare: 

 

Tabul Aspect pagină → grupul Opţiuni de foaie → se bifează casetele de opţiune Imprimare 

pentru Linii de grilă şi/ sau Titluri (tabul Page Layout → grupul Sheet Options → se bifează 

casetele de opţiune Print pentru Gridlines şi/sau Headings) 

Observaţie:  Aceleaşi setări se pot face şi în caseta de dialog Iniţializare pagină → fila Foaie → 

rubrica Imprimare → bifarea opţiunilor Linii de grilă şi Titluri rânduri şi coloane 

(caseta de dialog Page Setup → fila Sheet → rubrica Print → bifarea opţiunilor Gridlines, 

respectiv Row and Column Headings) 

 

 Centrarea conţinutului pe pagină 

Centrarea pe verticală şi/sau orizontală a conţinutului foii de calcul pe paginile tipărite se face 

din: 

Caseta de dialog Iniţializare pagină → fila Margini → rubrica Centrare pe pagină (caseta de 

dialog Page Setup → fila Margins → rubrica Center on Page) → se bifează Pe orizontală 

(Horizontally) şi/sau Pe verticală (Vertically) 

 

 Crearea şi modificarea antetului şi a subsolului 

Configurarea acestor zone se poate realiza astfel: 

1. Tabul Inserare → grupul Text → butonul Antet şi subsol (tabul Insert → grupul Text → 

butonul Header & Footer) 

ceea ce va conduce la trecerea automată a foii de calcul în modul de vizualizare Aspect pagină 

(Page Layout) şi la afişarea în panglica aplicaţiei a instrumentelor de lucru cu antetul şi subsolul 

– Instrumente antet şi subsol (Header & Footer Tools), cu tabul Proiectare (Design); 
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2. Clic în una dintre cele trei casete (stânga, centru, dreapta) destinate antetului  - pentru a crea 

antet sau în una dintre cele trei casete destinate subsolului – pentru a crea subsol; poziţia 

casetei determina alinierea informaţiilor introduse; 

3. Se introduc informaţiile, care pot fi texte obişnuite introduse de la tastatură sau câmpuri cu 

diverse informaţii predefinite, ce pot fi inserate cu ajutorul butoanelor tabului Proiectare 

(Design) →  grupurile Antet şi subsol (Header & Footer) şi Elemente antet şi subsol 

(Header & Footer Elements), cum ar fi: 

 

- butoanele Antet (Header), respectiv Subsol (Footer) →  deschid liste cu informaţii 

predefinite ce pot fi inserate în casetele de antet, respectiv de subsol 

- butonul Număr de pagină (Page Number) → numărul paginii 

- butonul Număr de pagini (Number of Pages) → numărul total de pagini 

- butonul Data curentă (Current Date) → data curentă 

- butonul Ora curentă (Current Time) → ora curentă 

- butonul Cale fişier (Path File) → calea către şi numele registrului curent 

- butonul Nume fişier (File Name) → numele registrului curent 

- butonul Nume foaie (Sheet Name) → numele foii de calcul 

- butonul Imagine (Picture) → inserarea unei imagini din fişier 

- butonul Formatare imagine (Format Picture) → opţiunile de formatare ale imaginii inserate 

 

Deplasarea între zona de antet şi cea de subsol se poate face din grupul Navigare (Navigation) 

→ butoanele Salt la antet (Go To Header) şi Salt la subsol (Go o Footer). 

 

4. Se stabilesc, dacă este cazul, prin bifare sau debifare, opţiuni suplimentare, din tabul 

Proiectare →  grupul Opţiuni (tabul Design →  grupul Options). Semnificaţia bifării 

opţiunilor este: 

- Prima pagină diferită (Different First Page) – elimină antetul şi subsolul deja create de pe 

prima pagină, urmând eventual a se introduce altele noi 

- Paginile pare diferă de cele impare (Different Odd & Even Pages) – antet şi subsol diferite 

pe paginile pare şi pe cele impare 

- Scalare la document (Scale with Document) – antetul şi subsolul se vor ajusta cu acelaşi 

factor de scalare ca şi foaia de calcul 

- Aliniere la marginile paginii (Align with Page Margins) – marginile antetului şi ale 

subsolului se aliniază cu marginile stânga şi dreapta ale paginii 

5. Se părăseşte zona de antet/subsol cu clic într-o celulă a foii de calcul şi se revine, eventual, în 

modul de vizualizare Normal. 

Observaţie:  Antetul şi subsolul pot fi create şi modificate şi din caseta de dialog Iniţializare pagină 
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→ fila Antet/Subsol (caseta de dialog Page Setup → fila Header/Footer), introducând 

diverse informaţii predefinite din listele casetelor Antet: (Header:), respectiv Subsol: 

(Footer:), sau creând antet/subsol particularizat, cu butoanele Antet particularizat… 

(Custom Header...) şi Subsol particularizat… (Custom Footer...). 

    
 

 

Ce aţi învăţat în acest capitol ? 

 Cum se utilizează diversele moduri de vizualizare 

 Cum se formatează paginile unei foi de calcul  

 

4.10. Imprimarea 

4.10.1. Imprimarea parţială sau integrală a unei foi sau a întregului 
registru 

1. Pentru a imprima: 

- O zonă a unei foi de calcul → se selectează respectiva regiune 

- Întreaga foaie de calcul → se selectează orice celulă din respectiva foaie de calcul 

- Câteva foi de calcul → se selectează respectivele foi de calcul 

- Întregul registru → se selectează orice celulă din oricare foaie de calcul 

- Un tabel definit ca Excel Table din foaia de calcul → se dă clic într-o celulă a tabelului 

2. Butonul Office → Imprimare (Office Button → Print) sau (Ctrl + P) 

3. În caseta de dialog Imprimare (Print), la rubrica De imprimat: (Print what:), se optează 

pentru: Selecţie (Selection), Foile active (Active sheet(s)), Tot registrul de lucru (Entire 

workbook) sau Tabel (Table).  

Observaţie:  dacă o foaie de calcul are definită zonă de imprimare (Print Area), doar această zonă va 

fi tipărită. Dacă nu se doreşte tipărirea doar a zonei de imprimare, se va bifa opţiunea 

Ignorare zone de imprimare (Ignore print areas). 
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4.10.2. Stabilirea opţiunilor de imprimare 

Caseta de dialog Imprimare (Print) permite stabilirea următoarelor aspecte: 

 Rubrica Imprimantă (Printer) → caseta Nume (Name) →  selectarea imprimantei la care se 

va face tipărirea. 

 Zonă de imprimat (Print Range) →  tipărirea zonelor de imprimat definite anterior sau, în 

cazul în care nu s-au definit, a întregului document - Toate (All) sau a unor anumite pagini, 

specificate în casetele De la: (From:) şi La: (To:) ale opţiunii Pagini (Page(s)). 

 Imprimare în fişier (Print to file) → tipărirea într-un fişier de imprimare 

  Număr de copii (Number of Copies) →  numărul de exemplare de imprimat 

 Asamblare (Collate) – pentru exemplare multiple - imprimă toate paginile specificate pentru 

un exemplar, apoi imprimă următorul exemplar  

Observaţie:  Pentru a imprima întregul conţinut al registrului sau zona de imprimare (dacă a fost 

definită) fără a mai schimba alte opţiuni, se poate solicita tipărirea rapidă, din: Buton 

Office → Imprimare → Imprimare rapidă (Office Button → Print → Quick Print). 

 

 

Ce aţi învăţat în acest capitol ? 

 Cum se realizează tipărirea întregului registru, a unei foi de calcul sau a unei zone a acesteia.  

 Care sunt şi cum se stabilesc opţiunile de tipărire. 
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4.11. Realizarea unor aplicaţii practice 

4.11.1.  Propunere temă practică – Situaţie tabelară şi graficul asociat 

Tema propusă:  

1. Să se realizeze registrul de lucru Angajaţi cu două foi de calcul (Stat şi Diverse). 

2. În foaia de calcul Stat, începând din celula A4, introduceţi tabelul cu capul de tabel de mai 

jos: 
 

 

Nr. 

Crt. 
Nume Prenume 

Sal. 

Tarifar 
Reţineri Sporuri 

Sal. 

Brut 
Impozit 

Salariu 

Net 
 

 

3. Sub capul de tabel se introduc datele a 10 persoane, efectuând calculele, ca în figura 

următoare. 

4. Nr. Crt. se introduce ca serie numerică de numere în progresie aritmetică. 

5. Se sortează tabelul după Nume, crescător. 

6. Să se realizeze o diagramă de tip Structură radială (Pie) care să reprezinte Salariile nete ale 

angajaţilor. 
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4.11.2. Propunere temă practică – Tabel de buget cu grafice de 
structură 

Tema propusă:  

1. Să se realizeze registrul Proiect şi în prima foaie de calcul să se creeze tabelul cu următorul 

cap de tabel: 
 

Nume 
salariat 

Ore 
lucrate 

Tip 
activitate 

Cost/salariat 
Cost 

materiale 
Total 

activitate 

 

2. Sub antet se introduc datele a 10 persoane, efectuând calculele, ca în figura următoare: 

3. Tabelul conţine formule după cum se vede în figura următoare: 
 

 

4. Să se formateze condiţional cu bare de date costurile/salariat. 
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5. Să se realizeze o diagramă de tip Structură radială (Pie) pe care să se reprezinte Total 

activitate pentru fiecare salariat şi o diagramă de tip Coloană (Column) pe care să se 

reprezinte Cost materiale şi Cost salariat pentru fiecare activitate în parte. 
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4.11.3. Propunere activitate practică - Situaţie tabelară cu facilităţi de 
bază ale aplicaţiei 

Tema propusă:  

1. Să se introducă într-un document nou, salvat sub numele „Tema Calc”, pe o foaie de calcul 

numită „Exerciţiu”,  începând cu celula A3, un tabelul cu următoarea structură: 

Nume 

cursant 

Nume 

curs 

Total 

de 

plată 

Plătit Rest Nota 

Teorie 

Nota 

Practică 

Media Obs. Calificativ 

Popa Birotica 300 200  8 7    

Ioan Engleza 400 250  10 8    

Dima Birotica 280 280  5 7    

Sima SQL 280 200  9 10    

Enciu SQL 300 300  5 4    

Coman Birotica 400 280  9 9    

Linca SQL 400 400  4 4    

Radu Birotica 280 100  8 7    

Toma Engleza 300 300  3 6    

Bota Engleza 400 300  6 7    

Celelalte coloane se calculează după formulele: 

Rest = Total de plată – Plătit 

Media = Media aritmetică a celor două note (Nota Teorie şi Nota Practică) 

Obs. = Dacă Rest este diferit de 0, să fie afişat mesajul: “Nu a plătit tot”, altfel, “Achitat 

integral” 

Calificativ =  - Dacă Media <= 6, să se afişeze mesajul “Slab”; 

- Dacă 6 < Media <= 8, să se afişeze mesajul “Mediocru”; 

- Dacă Media > 8, să se afişeze mesajul “Bine”; 

2. Sa se afişeze sub tabel, aplicând funcţiile corespunzătoare: Cea mai mică medie obţinută, Cel 

mai mare rest de plată şi Media sumelor plătite de cursanţi. 

3. Să se formateze condiţional câmpul Media pentru acele medii care sunt cuprinse între 6 şi 9. 

4. Să se creeze graficul tip coloane pe baza coloanelor Cursant şi Media şi să se formateze acest 

grafic. 

5. Să se îngheţe în derulare capul de tabel. 

6. Să se calculeze suma totală încasată (câmpul Plătit) la nivelul fiecărui curs şi să se reprezinte 

grafic aceste subtotaluri (într-o diagramă tip sector de cerc, plasată într-o foaie de calcul 

nouă). 

7. Să se formateze pagina astfel încât să fie vizibile la imprimare numele (antelele) liniilor şi ale 

coloanelor şi grilele foii de calcul. 

8. Să se creeze un antet în care să fie afişat, în partea dreaptă, numele documentului curent şi în 

partea stângă, numele foii de calcul curente. 


